
      

  

 ปัจจุบนัน้ีนบัเป็นยคุแห่งขอ้มูลและข่าวสารที่เรียกกนัสั้นๆว่า “ยุคโลกาภิวัฒน์”   ความกา้วหน้าทาง
เทคโนโลยเีป็นส่วนส าคญัในชีวติประจ าว ันของมนุษย ์มากขึ้ น “คอมพิวเตอร์” (COMPUTER)  นับว่า
เป็นเทคโนโลยีประเภทหน่ึงที่ก ้าวเข ้ามามีบทบาทต่อการด ารงชีวิตของมนุษย ์เ ป็นอย่างมาก การ
เรียนวชิาคอมพวิเตอร์จึงเป็นส่ิงที่จ  าเป็นส าหรับเยาวชนในปัจจุบัน  ดังนั้ นสถานศึกษาต่างๆ  จึงจ ัดให้
วิชาคอมพิวเตอร์เป็นส่วนหน่ึงของการเรียนการสอน   ในระดบัชั้นอนุบาล  ประถมศึกษา  มธัยมศึกษา  
และ อาชีวศึกษา 

  ดงันัน้จึงไดเ้ล็งเห็นความส าคญัในการพฒันาการเรียนการสอนคอมพิวเตอร์ในสถานศึกษา    และได้
จดัท าแผนการจดัการเรียนรู้วิชาคอมพิวเตอร์โดยเรียบเรียงจากเอกสาร และซอฟแวร์ต่างๆ  ให้กบัแต่ละสถาบนั 
และสอดคลอ้งกบัสาระการเรียนรู้ตามหลกัสูตรแกนกลางการศึกษาขั้นพื้นฐาน  พ.ศ. ๒๕๕๑   ของ
กระทรวงศึกษาธิการ   ภายในเล่มมีการใช้โปรแกรม Adobe  Dreamweaver CS5 ส าหรับสร้างโครงงาน
คอมพิวเตอร์ นอกจากน้ียงัมีแบบฝึกหัดทา้ยบท ส าหรับนักเรียนเพื่อเสริมทกัษะทั้งภาคทฤษฎี และภาคปฏิบตัิ   
เม่ือนกัเรียนไดเ้รียนรู้ และฝึกปฏิบติัจนครบเน้ือหาภายในเล่มแลว้ จะท าใหน้กัเรียนมีความรู้ความสามารถที่จะ
ใชค้อมพวิเตอร์เบื้องตน้ และใชค้อมพวิเตอร์ระบบมลัติมีเดียในโปรแกรมต่างๆ ได ้

     คณะผูจ้ดัท  าไดเ้รียบเรียงแผนการจดัการเรียนรู้วิชาคอมพิวเตอร์เล่มน้ีขึ้นมา เพื่อเป็นประโยชน์ต่อ
การเรียนการสอนส าหรับสถานศึกษาต่างๆ และเป็นการเตรียมความพร้อมให้แก่ผูเ้รียนในการน าไปประยกุต์
กบัการท างานในยคุปัจจุบนั มิไดมี้จุดมุ่งหมายเพือ่จ  าหน่าย 
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หน่วยการเรียนรู้ที่  1 การใชง้านโปรแกรม  Adobe Dreamweaver  CS 5  เบื้องตน้ 
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หน่วยการเรียนรู้ที่  2 การใส่ขอ้ความและรูปภาพลงในเวบ็เพจ 38 
หน่วยการเรียนรู้ที่  3 การสร้างตาราง (Table) 66 
หน่วยการเรียนรู้ที่  4 การเช่ือมโยงเวบ็เพจ  (Link) 101 
หน่วยการเรียนรู้ที่  5 การจดัแบ่งหนา้เวบ็เพจดว้ย (Frame) 113 

สารบัญ 



ค ำอธิบายรายวชิาคอมพวิเตอร์ 

     เวลา๔๐  ชั่วโมง 

       มุ่งเน้นให้ผู้เรียนเข้าใจหลักการและวิธีการสร้างโครงงานคอมพิวเตอร์  โดยมี
จุดมุ่งหมายหลักคือต้องการให้ผู้เรียนศึกษา วิเคราะห์ อภิปราย สรุป เกี่ยวกับ
ความหมาย ประเภท คุณค่าโครงงานคอมพิวเตอร์  ขั้นตอนการพัฒนาโครงงาน
คอมพิวเตอร์  ใช้คอมพิวเตอร์ช่วยสร้างชิ้นงานหรือโครงงานตามหลักการท า
โครงงาน  ผลกระทบด้านสังคมและสิ่งแวดล้อมที่เกิดจากงานที่สร้างขึ้น เพื่อหา
แนวทางปรับปรุงและพัฒนา 
 ฝึกปฏิบัติท าโครงงานคอมพิวเตอร์ตามหลักการท าโครงงาน โดยใช้ความรู้ 
ความคิด จินตนาการ ทักษะ เหตุผล และกระบวนการต่างๆ  ทางเทคโนโลยี
สารสนเทศ ตลอดจนประสบการณ์ด้านคอมพิวเตอร์ โดยมีการ บูรณาการความรู้
จากกลุ่มสาระการเรียนรู้ต่าง ๆ หรือความรู้ด้านอื่น ๆ   ที่เกี่ยวข้องเข้ามาร่วมในการ
พัฒนาโดยใช้กระบวนการเทคโนโลยี การบวนการสืบค้น กระบวนการแก้ปัญหา 
กระบวนการคิดวิเคราะห์  

เพื่อให้เกิดความรู้ ความเข้าใจ และสามารถน าเอาคอมพิวเตอร์มาประยุกต์ใช้
ในการสร้างโครงงานได้อย่างมีจิตส านึกและมีความรับผิดชอบ 



  1 

 
 
 

     สาระที่   ๒  การออกแบบและเทคโนโลย ี

มาตรฐาน ง  ๒. ๑  เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ี ออกแบบและสร้างส่ิงของเคร่ืองใช ้หรือวธีิการ  ตาม
กระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรคเ์ลือกใชเ้ทคโนโลยใีนทางสร้างสรรคต่์อชีวติ สงัคม ส่ิงแวดลอ้ม และมี
ส่วนร่วมในการจดัการเทคโนโลยทีี่ย ัง่ยนื 

 

ช้ัน ตัวช้ีวดั  สาระการเรียนรู้แกนกลาง 

ม.๔-๖ ๑.อธิบายและเช่ือมโยงความสมัพนัธร์ะหวา่ง 
เทคโนโลยกีบัศาสตร์อ่ืนๆ 

๑.ระบบเทคโนโลยปีระกอบดว้ย ตวัป้อน (Input)  กระบวนการ 
(Process)   ผลลพัธ ์(Output)    ทรัพยากรทางเทคโนโลย ี
(Resources)   ปัจจยัที่เอ้ือหรือขดัขวางต่อเทคโนโลย ี  
(Consideration) 

 ๓.สร้างและพฒันาส่ิงของเคร่ืองใชห้รือวิธีการ 
ตามกระบวนการเทคโนโลยีอย่างปลอดภัย
โดยถ่ ายทอดความคิด เ ป็นภาพฉายและ
แบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  หรือ
ถ่ายทอดความคิดของวิธีการเป็นแบบจ าลอง
ความคิดและการรายงานผลโดยใช้ซอฟแวร์
ช่วยในการออกแบบหรือน าเสนอผลงาน 

๑. การสร้างส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการ
เทคโนโลยจีะท าให้ผูเ้รียนท างานอยา่งเป็นระบบสามารถยอ้นกลบั
มาแกไ้ขไดง่้าย 

 ๔.มีความคิดสร้างสรรคใ์นการแกปั้ญหาหรือ
สนองความตอ้งการในงานที่ผลิตเองหรือ 
การพฒันาผลิตภณัฑท์ี่ผูอ่ื้นผลิต 

๑.การวเิคราะห์ระบบเทคโนโลยที  าใหท้ราบเก่ียวกบัปัจจยัในดา้น
ต่างๆ ที่มีผลต่อการแกปั้ญหาหรือสนองความตอ้งการ 
๒.การพฒันาส่ิงของเคร่ืองใช ้ตอ้งค  านึงถึงหลกัการวเิคราะห์
ผลิตภณัฑเ์บื้องตน้ 

ตัวช้ีวดัและสาระแกนกลาง 



  2 

          สาระที ่๓ เทคโนโลยสีารสนเทศและการส่ือสาร  
              มาตรฐาน ง ๓.๑     เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยสีารสนเทศในการสืบคน้ขอ้มูล การเรียนรู้  การ
ส่ือสาร  การแกปั้ญหา  การท างานและอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล และมีคุณธรรม 

ช้ัน ตัวช้ีวดั  สาระการเรียนรู้แกนกลาง 

ม.๔-๖ ๑. อธิบายองคป์ระกอบของระบบสารสนเทศ ๑.องคป์ระกอบของระบบสารสนเทศ  ไดแ้ก่ ฮาร์ดแวร์ ซอฟตแ์วร์ 
ขอ้มูล บุคลากรและขั้นตอนการปฏิบติังาน 

 ๒. อธิบายองคป์ระกอบและหลกัการท างาน
ของคอมพวิเตอร์ 

๒.การท างานของคอมพวิเตอร์ประกอบดว้ยหน่วยส าคญั ๕ หน่วย
ไดแ้ก่ หน่วยรับเขา้หน่วยประมวลผลกลาง  หน่วยความจ าหลกั  
หน่วยความจ ารองและหน่วยส่งออก  
-  หน่วยประมวลผลกลาง ประกอบดว้ยหน่วยควบคุมและหน่วย
ค านวณและตรรกะ  
-  การรับส่งขอ้มูลระหวา่งหน่วยต่างๆ  จะผา่นระบบทางขนส่ง
ขอ้มูลหรือบสั 

 ๓. อธิบายระบบส่ือสารขอ้มูลส าหรับเครือข่าย
คอมพวิเตอร์ 

๓.ระบบส่ือสารขอ้มูลประกอบดว้ย ข่าวสาร    ผูส่้ง ผูรั้บ  ส่ือกลาง  
โพรโทคอล 
•เครือข่ายคอมพวิเตอร์จะส่ือสารและรับส่งขอ้มูลกนัไดต้อ้งใชโ้พร
โทคอลชนิดเดียวกนั 
•วธีิการถ่ายโอนขอ้มูลแบบขนานและแบบอนุกรม 

 ๔. บอกคุณลกัษณะของคอมพวิเตอร์และ
อุปกรณ์ต่อพว่ง 

 ๔.คุณลักษณะ(specification)ของอุปกรณ์คอมพิว เตอร์ และ
อุปกรณ์ต่อพว่ง  เช่น  ความเร็วและความจุของฮาร์ดดิสก ์

 
 
 
 



 

โครงสร้างรายวิชา 
 

วชิาคอมพวิเตอร์   เวลา   ๒๐ ช่ัวโมง 

 
ล าดับ
ที่ 

มฐ/ตชว. สาระส าคญั ช่ือหน่วยการเรียนรู้ 
เวลา   
(ช.ม.) 

น ้าหนัก
คะแนน 

๑ ง ๓.๑ 

     เข้าใจ เห็นคุณค่าและใช้กระบวนการ
เทคโนโลยีสารสนเทศในการสืบคน้ขอ้มูล 
การเรียนรู้  การส่ือสาร  การแก้ปัญหา  การ
ท างานและอาชีพอย่างมีประสิทธิภาพ 
ประสิทธิผล และมีคุณธรรม 

การใชง้านโปรแกรม  
Adobe Dreamweaver  
CS 5  เบื้องตน้ 

  

๒ ง ๒.๑ 

- สร้างและพัฒนา ส่ิงของเค ร่ืองใช้หรือ
วิธีการ ตามกระบวนการเทคโนโลยีอย่าง
ปลอดภยัโดยถ่ายทอดความคิดเป็นภาพฉาย
และแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  
หรือ ถ่ ายทอดความคิดของวิ ธีการเ ป็น
แบบจ าลองความคิดและการรายงานผลโดย
ใช้ซอฟแว ร์ ช่วยในการออกแบบหรือ
น าเสนอผลงาน 

การใส่ขอ้ความและ
รูปภาพลงในเวบ็เพจ 
 

  

๓ ง ๒.๑ 

- สร้างและพัฒนา ส่ิงของเค ร่ืองใช้หรือ
วิธีการ ตามกระบวนการเทคโนโลยีอย่าง
ปลอดภยัโดยถ่ายทอดความคิดเป็นภาพฉาย
และแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  
หรือ ถ่ ายทอดความคิดของวิ ธีการเ ป็น
แบบจ าลองความคิดและการรายงานผลโดย
ใช้ซอฟแว ร์ ช่วยในการออกแบบหรือ
น าเสนอผลงาน 

การสร้างตาราง 
(Table) 

  

เวลาตามหน่วย   
สอบปลายปี   



 

โครงสร้างรายวิชา 

วชิาคอมพวิเตอร์  เวลา     ๒๐    ช่ัวโมง 
 

                                                                 

ล าดบัที ่ มฐ/ตชว. สาระส าคญั ช่ือหน่วยการเรียนรู้ 
เวลา   
(ช.ม.) 

น า้หนัก
คะแนน 

๔ ง ๒.๑ - อธิบายและเช่ือมโยงความสมัพนัธร์ะหวา่ง
เทคโนโลยกีบัศาสตร์อ่ืนๆ 
- มีความคิดสร้างสรรคใ์นการแกปั้ญหาหรือ
สนองความตอ้งการในงานที่ผลิตเองหรือ
การพฒันาผลิตภณัฑท์ี่ผูอ่ื้นผลิต 

การเช่ือมโยงเวบ็เพจ  
(Link) 

  

๕ ง ๒.๑ - สร้างและพฒันาส่ิงของเคร่ืองใชห้รือ
วธีิการ ตามกระบวนการเทคโนโลยอียา่ง
ปลอดภยัโดยถ่ายทอดความคิดเป็นภาพฉาย
และแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  
หรือถ่ายทอดความคิดของวธีิการเป็น
แบบจ าลองความคิดและการรายงานผลโดย
ใชซ้อฟแวร์ช่วยในการออกแบบหรือ
น าเสนอผลงาน 
- มีความคิดสร้างสรรคใ์นการแกปั้ญหาหรือ
สนองความตอ้งการในงานที่ผลิตเอง หรือ
การพฒันาผลิตภณัฑท์ี่ผูอ่ื้นผลิต 

การจดัแบ่งหนา้เวบ็เพจ
ดว้ย (Frame) 

  

เวลาตามหน่วย   

สอบปลายปี   



การใช้งานโปรแกรม  Adobe Dreamweaver  CS 5  เบือ้งต้น 

มาตรฐานการเรียนรู้/ ตัวช้ีวดั 

กลุ่มสาระการงานอาชีพและเทคโนโลย ี

สาระที ่๓ เทคโนโลยสีารสนเทศและการส่ือสาร 

      มาตรฐาน ง ๓.๑ เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยสีารสนเทศในการสืบคน้ขอ้มูล การ 

เรียนรู้ การส่ือสาร การแกปั้ญหา การท างานและอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล มีคุณธรรม 

ตัวช้ีวดั 
 ๑.ง ๓.๑/๑ อธิบายองคป์ระกอบของระบบสารสนเทศ 

 ๒.ง ๓.๑/๒ อธิบายองคป์ระกอบและหลกัการท างานของคอมพิวเตอร์  

 ๓.ง ๓.๑/๓ อธิบายระบบส่ือสารขอ้มูล ส าหรับเครือข่ายคอมพิวเตอร์  

 ๔.ง ๓.๑/๔ บอกคุณลกัษณะของคอมพิวเตอร์และอุปกรณ์ต่อพ่วง 

สาระส าคญั 
       เขา้ใจ เห็นคุณค่า และใชก้ระบวนการเทคโนโลยสีารสนเทศในการสืบคน้ขอ้มูล การเรียนรู้  การส่ือสาร  

การแกปั้ญหา  การท างาน  และอาชีพอยา่งมีประสิทธิภาพ ประสิทธิผล  

สาระการเรียนรู้ 

- ความรู้ 
๑.เขา้ใจองคป์ระกอบ คุณลกัษณะของระบบสารสนเทศ 
๒.อธิบายระบบส่ือสารขอ้มูลส าหรับเครือข่ายคอมพวิเตอร์ 

๓. เขียนโปรแกรมภาษาและพฒันาโครงงานคอมพวิเตอร์ 
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 - ทกัษะ / กระบวนการ 

    ๑.อธิบาย สรุป องคป์ระกอบโดยรวมของคอมพวิเตอร์ 

    ๒.ฝึกหดัการเขียนโปรแกรมภาษาและพฒันาโครงงานคอมพวิเตอร์ 

- คุณลกัษณะทีพ่งึประสงค์ 

   ๑.มีวนิยั 

   ๒.ใฝ่เรียนรู้ 

   ๓.มุ่งมัน่ในการทางานรู้เรียนรู้ 
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พืน้ฐานการสร้างเว็บเพจ 

 

เวิลด์ไวด์เว็บ (World Wide Web หรือ  WWW ) หรือที่เรียกกนัสั้นๆ ว่า เว็บ (Web) เป็นบริการขอ้มูล
ข่าวสารในแบบส่ือประสมหรือมลัติมีเดีย (Multimedia) กล่าวคือ ขอ้มูลเหล่าน้ีจะเป็นขอ้มูลที่มีทั้งขอ้ความ, 
ภาพ และเสียงประกอบกนั แทนที่จะมีเพียงตวัอกัษรละลานตาเพียงอยา่งเดียว จึงสามารถเรียกร้องความสนใจ
จากผู ้ชมได้เป็นอย่างดี  ความก้าวหน้าของเทคโนโลยีปัจจุบัน ท าให้ข้อมูลประเภทน้ีสามารถแสดง
ภาพเคล่ือนไหวในแบบของภาพยนตร์ และแสดงเสียงไดคุ้ณภาพระดบัเดียวกบัแผน่ซีดีเลยทีเดียว 

ขอ้มูลน้ีจะถูกแบ่งเป็นหน้า ๆ แต่ละหน้าจะถูกเขียนขึ้นด้วยภาษาทางคอมพิวเตอร์ที่พฒันาขึ้นใหม่ 
เรียกว่า ภาษา HTML (Hyper Text Markup Language) ซ่ึงสามารถเช่ือมโยงถึงกนัไดโ้ดยไม่จ าเป็นตอ้งอยูท่ี่
เดียวกนั ดงันั้น       ขอ้มูลจากทุกมุมโลกจึงถูกโยงใยไปมาถึงกนัไดร้าวกบัใยแมงมุม    จึงเรียกว่า   เวิลด์ไวด์เว็บ 
หรือ  เครือข่ายใยแมงมุม 

  ส่วนประกอบใน WWW 
 Home Page

เว็บเพจหน้าแรกสุดของขอ้มูลแต่ละเร่ือง ซ่ึงก็เปรียบเสมือนหน้าปกของหนังสือนั่นเอง ส่วนของ
โฮมเพจน้ีจะเป็นส่วนที่บอกให้ทราบว่าขอ้มูลน้ีเป็นขอ้มูลเร่ืองใด พร้อมกบัมีสารบญัในการเลือกไปยงัหัวขอ้
ต่างๆ ในเร่ืองนั้นๆ ดว้ย 

 Web Site
เป็นเคร่ืองมือที่ใชใ้นการจดัเก็บเวบ็เพจแต่ละองคก์รที่จะน าเสนอขอ้มูลของตนในรูปของเวบ็น้ีมกัจะมี

เวบ็ไซตเ์ป็นของตนเอง และมกัใชช่ื้อองคก์รเป็นช่ือเวบ็ไซตเ์พือ่ใหผู้ส้นใจสามารถจดจ าไดง่้าย 

 Web Page
เอกสารขอ้มูลในแต่ละหนา้ซ่ึงถูกเขียนขึ้นดว้ยภาษา HTML ขอ้มูลที่แสดงในเวบ็เพจแต่ละหน้าน้ีอาจ

ประกอบดว้ยขอ้ความ , ภาพ และเสียง จึงเป็นขอ้มูลแบบส่ือประสม หรือ มลัติมีเดีย 

การใช้งานโปรแกรม  Adobe Dreamweaver  CS 5  เบือ้งต้น 
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 เวบ็บราวเซอร์ (Web Browser)
เวบ็เพจแต่ละหนา้เป็นเอกสารขอ้มูลที่ถูกเขียนขึ้นดว้ยภาษา HTML ดงันั้น การที่เคร่ืองของเราจะอ่าน

และแสดงผลเวบ็เพจเหล่าน้ีได ้ จะตอ้งมีโปรแกรมพเิศษส าหรับท าหนา้ที่น้ีโดยเฉพาะ โปรแกรมเหล่าน้ี เรียกวา่ 
เว็บบราวเซอร์ (Web Browser)   ซ่ึงมีอยูม่ากมายในปัจจุบนั แต่ที่รู้จกักนัดีเห็นจะไดแ้ก่ Internet Explorer 
ของบริษัทไมโครซอฟท์     และ   Netscape Navigator   ของ AOL ซ่ึงทั้งสองโปรแกรมน้ีมีขีดความสามารถที่
ใกลเ้คียงกนัเป็นอยา่งมาก 

  การสร้างเวบ็เพจ 
การสร้างเวบ็เพจ จะกระท าได ้2 ทางดว้ยกนั คือ 
1. สร้างขึน้เอง

โดยการเรียนรู้ค  าสั่งของภาษา HTML แลว้พิมพเ์ขา้ไปผ่านทางโปรแกรม Text Editor ใดๆ เช่น Notepad 
โดยตรง 

2. ใช้โปรแกรมส าหรับสร้างเว็บ
โดยใชโ้ปรแกรมต่าง ๆ ที่มีความสามารถในการสร้างเวบ็เพจ ซ่ึงมีอยูม่ากมายหลายโปรแกรมดว้ยกนั การสร้าง
เวบ็เพจดว้ยวธีิน้ี เราไม่จ าเป็นตอ้งเรียนรู้ค  าสัง่ของภาษา HTML แต่อยา่งใด โปรแกรมเหล่าน้ีจะท าการแปลงให้
เราเองโดยอตัโนมตัิ  ปัจจุบนัมีโปรแกรมที่ก  าลงัไดรั้บความนิยม  Adobe Dreamweaver CS5,  Adobe 
Dreamweaver UltraDev , Adobe HomeSite  , Microsoft FrontPages 
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   ภาษา HTML 
  HTML (Hypertext Markup Language) เป็นภาษาที่ใช้ในการเขียนโปรแกรมภาษาหน่ึงของ
คอมพวิเตอร์ เพือ่ตอบสนองในการแสดงผลบนจอภาพในระบบอินเตอร์เน็ต (Internet) ในลกัษณะของเวบ็เพจ 
ซ่ึงสามารถแสดงผลไดท้ั้งภาษาไทยและภาษาองักฤษ รวมทั้งรูปทรงกราฟฟิค, ภาพน่ิง, ภาพเคล่ือนไหว, เสียง 
หรือแมก้ระทัง่การเช่ือมโยงไปยงัเวบ็ไซตอ่ื์นๆ ในระบบอินเตอร์เน็ต 
 ภาษา HTML เป็นภาษาที่มีลกัษณะเป็น โค้ด (Code) กล่าวคอื จะเป็นไฟลท์ี่เก็บขอ้มูลที่เป็นตวัอกัษรใน
มาตรฐานของ  รหัสแอสกี (ASCII Code) โดยเขียนอยูใ่นรูปของเอกสารขอ้ความ (Text Document)   ดงันั้นจึง
ท าใหง่้ายต่อการเรียนรู้ สามารถก าหนดรูปแบบและโครงสร้างไดง่้ายดว้ยภาษา HTML   น้ีไดถู้กพฒันาตั้งแต่รุ่น 
1.0 , 2.0 , 3.0 จนถึงรุ่น 4.0 ในปัจจุบนั นอกจากน้ี  ภาษา HTML ยงัมีลกัษณะพเิศษที่ควรทราบดงัน้ี 

สามารถใช้ได้กับโปรแกรมสร้างและแก้ไขไฟล์ขอ้ความ (Text Editor) ได้แก่ Notepad, Word 
Processing ต่างๆ ซ่ึงง่ายต่อการเรียนรู้ และไฟลท์ี่ไดจ้ะมีขนาดเล็ก 

HTML ที่ถูกบนัทึกใน Text Editor จะมีชนิดของไฟล์เป็น HTM ส าหรับในระบบปฏิบตัิการ MS-
DOS และจะมีชนิดเป็น HTM หรือ HTML ในระบบปฏิบตัิการยนิูกซ์ , วนิโดวส์ 

สามารถท างานไดบ้นเว็บบราวเซอร์ทุกตวัที่สนับสนุน HTML ได้แก่ Netscape รุ่นต่างๆ Microsoft 
Internet Explorer , American Online , Mosaic เป็นตน้ 

  โครงสร้างของภาษา HTML 
 การสร้างเอกสาร HTML มีองคป์ระกอบหลกัอยู ่ 2  ส่วน คือ ส่วนที่เป็นขอ้ความที่จะพิมพ ์และส่วนที่
เป็นค าสัง่ ส าหรับส่วนที่เป็นค าสัง่ที่จะน ามาใชเ้พือ่เปล่ียนแปลงรูปร่างและแบบของตวัอกัษรหรือเอกสารใด ๆ 
(Attribute) จะถูกเรียกว่า แท็ก (Tag)  และจะเขียนไวอ้ยู่ในเคร่ืองหมาย < > ในรูปแบบ <แท็ก> เช่น    
<HTML>, <B> ,<U>   เป็นตน้ โดยแต่ละแทก็จะท าหนา้ที่แตกต่างกนัไป แบ่งออกเป็น   2   กลุ่ม ดงัน้ี 

1.   รูปแบบค าสั่งที่มีเพียงค  าสั่งเดียวหรือมีแท็กเดียว สามารถใชง้านไดเ้ลยและส้ินสุดความหมายดว้ย
ตวัมนัเอง เช่น <BR> , <WBR> เป็นตน้ 

2.   รูปแบบค าสัง่ที่แยกออกเป็น 2 ส่วน หรือแทก็คู่ คือ มีส่วนเร่ิมตน้และส่วนจบของค าสั่ง โดยที่ส่วน
จบของรูปแบบค าสัง่จะมีเคร่ืองหมาย Slash ( / ) ก ากบัไวห้นา้แทก็นั้น ๆ  
ตวัอยา่งเช่น 
  <HTML>………</HTML> 
  <B>……………</B> 
  <U>……………</U>  เป็นต้น 
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 ในการเขียนรูปแบบค าสั่งที่แยกออกเป็น 2 ส่วน หรือแท็กคู่ ค  าสั่งนั้นจะตอ้งเป็นค าสั่งที่สมมาตรกัน 
เช่น เม่ือเปิดดว้ยค าสั่ง  ตัวหนา <B> และขีดเส้นใต ้<U> เวลาปิดค าสั่งก็ตอ้งเปิดดว้ยขีดเส้นใตก่้อนแลว้จึงปิด
ดว้ยค าสัง่ตวัหนา ดังนี้ 

              <B><U>      ........ข้อความที่ต้องการ.......    </U ></ B > 
 
 

   ค าส่ังในการก าหนดโครงสร้างหลกั 
  รูปแบบการจดัวางต่อไปน้ีเป็นรูปแบบมาตรฐาน ประกอบไปดว้ยค าสั่งหลกัอยู ่4 ค  าสั่ง โดยมีลกัษณะการ

จดัวางและรายละเอียดดงัน้ี 
 <HTML> 
 <HEAD> 
 <TITLE> 
   ขอ้ความที่ตอ้งการน าแสดงผลบนแถบช่ือเร่ือง (Title bar) 
  </TITLE>   
   </HEAD> 

   </BODY> 
              ขอ้ความและค าสัง่ใด ๆ ที่ตอ้งการปรับแต่งหนา้เวบ็เพจ 
 
  </BODY> 

</HTML> 

 ค าสัง่หลกั   <HTML> .........</HTML>   เป็นค าสัง่ที่ท  าหนา้ที่บอกจุดเร่ิมตน้และจุดจบของเอกสาร 
HTML  

 ค าสั่งหลกั <HEAD> …… </HEAD> เป็นค าสั่งที่ท  าหน้าที่ก  าหนดส่วนหัวเร่ือง โดยจะประกอบดว้ย
ค าสัง่หลกั  <TITLE> …… </TITLE> ซ่ึงเป็นค าสัง่ที่ใชก้  าหนดขอ้ความที่ตอ้งการน ามาแสดงผลบน
แถบช่ือเร่ือง (Title bar) โดยก าหนดความยาวของขอ้ความไดไ้ม่เกิน 64 ตวัอกัษร 

 ค าสัง่หลกั <BODY> …… </BODY>  เป็นค าสัง่ที่ท  าหน้าที่ก  าหนดขอ้ความ และรูปแบบค าสั่งใดๆ ที่
ตอ้งการปรับแต่งเอกสารบนส่วนของจอภาพ และจะแสดงผลบนจอภาพเม่ือถูกเรียกใช้จากเว็บ
บราวเซอร์ 
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 การเรียกใช้โปรแกรม  Adobe  Dreamweaver  CS5 

       1)  การเรียกใชโ้ปรแกรม  Adobe  Dreamweaver  CS5 สามารถเรียกใชไ้ด ้ 2  วธีิ  ดงัน้ี   
วิธีที่  1   เรียกจากปุ่ ม  Start   
              1.   คลิกเมาส์ที่ปุ่ ม Start 
        2.   เล่ือนเมาส์ไปที่ Programs หรือ All Programs 
คลิกเมาส์ที่ช่ือ   Adobe Dreamweaver CS5 จะเขา้สู่  โปรแกรมไดท้นัที  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

วิธีที่  2  เรียกจากไอคอนบนเดสกท์อป 
             1.   ดบัเบิ้ลคลิกเมาส์ที่ไอคอนโปรแกรม                            บนเดสกท์อปจะเขา้สู่โปรแกรมไดท้นัท ี

2) เม่ือเปิดโปรแกรมแลว้จะแสดงหนา้ต่างที่เรียกวา่  Start page ที่มีตวัเลือก ดงัน้ี 

       1. Open a Recent Item  เปิดเอกสาร (หนา้เวบ็) เดิมที่สร้างไว ้
                     2. Create New สร้างเอกสารเปล่าตามรูปแบบที่เราเลือก เช่น HTML,   ColdFusion, 

PHP, ASP, CSS 
        3. Create from Samples สร้างเอกสารจากตน้แบบ จะไดเ้อกสารที่มีเน้ือหาเร่ิมตน้ ไม่ใช่

เอกสารเปล่า ใหเ้ราใชแ้กไ้ขต่อไปได ้

Adobe Dreamweaver CS5 
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ซ่ึงในที่น่ี เราจะคลิกเลือกเป็น  เพือ่สร้างหนา้เอกสาร  HTML ขึ้นมาใหม่ จากนั้นจะเขา้สู่
หนา้จอเร่ิมตน้ของโปรแกรม Dreamweaver 
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 การเรียกใช้ค าส่ังของโปรแกรม   

  การเรียกใชค้  าสัง่ในโปรแกรมท าได ้ 2  วิธี  ดงัน้ี 

การเรียกใช้ค าส่ังจากแถบเมนู 

            แถบเมนู (Menu bar) เป็นส่วนที่แสดงค าสั่งที่ถูกจดัไวเ้ป็นกลุ่มๆ เรียกว่า เมนู เพื่อความสะดวกใน
การเรียกใชค้  าสัง่ในแต่ละเมนูจะกระท าไดด้งัน้ี 

1.   คลิกที่ช่ือเมนู    
 2.   คลิกที่ช่ือค  าสัง่     
 
 

 
 
 
 
 
 

 การเรียกใช้ค าส่ังจากเมนูลดั (Context menu) 

         เมนูลัด (Context Menu) จะเป็นค าสั่งพิเศษที่โปรแกรมจดัเตรียมไวใ้ห้ โดยค าสั่งเหล่าน้ีจะเปล่ียนไป
ตามงานที่เราท าขณะนั้นการเรียกใชเ้มนูลดัจะกระท าไดโ้ดย 

 

คลกิปุ่ มขวา
ของเมาส์ 
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   การยกเลกิค าส่ังและการท าซ ้า 
 
 เลือกค าสัง่  Edit  >  Undo 
 และ 
 เลือกค าสัง่  Edit  >  Redo 

 
 
 

     การออกจากโปรแกรม   

การออกจากโปรแกรม  Dreamweaver  CS5   สามารถท าได ้ 3  วธีิ ดงัน้ี   
 วิธีที่  1 เลือกเมนูค  าสัง่   File   เลือกค าสัง่   Exit 
 วิธีที่  2         คลิกที่ปุ่ ม    ของหนา้ต่างโปรแกรม  
 วิธีที่  3         คลิกที่ไอคอน                   Adobe Dreamweaver CS5   ที่มุมบนซา้ยของหนา้ต่างโปรแกรม 
แลว้เลือกค าสัง่   Close  ดงัรูป 
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ส่วนประกอบของโปรแกรม   Dreamweaver CS5 

สญัลกัษณ์ของ Dreamwever  
แถบเมน ู(Menu bar) เป็นแถบท่ี
ใช้เก็บค าสัง่ทัง้หมดของโปรแกรม  

หน้าตา่งออกแบบเวบ็เพจ 
(Document Window) 

เป็นพืน้ท่ีส าหรับสร้างหน้าเวบ็ 

กลุม่หน้าต่างพาเนล (Panel Group) 
ท่ีช่วยเพิม่ความสามารถในการ

จดัการและออกแบบหน้าเวบ็ของเรา 

ก าหนดคณุสมบตัิขององค์ประกอบ
หน้าเวบ็ (Proprety Inspector) จะ

แสดงคา่ในการปรับแตง่
องค์ประกอบตา่งๆบนหน้าเวบ็ได้ 

แถบ
เคร่ืองมือ 
(Toolbar) 

ไอคอน  Workspace switcher   
ใช้จดัมมุมองการท างานให้เหมาะ 
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   แถบสถานะ (Status bar) 

   แถบสถานะของ Dreamweaver จะแสดงขอ้มูลเพิ่มเติมเก่ียวกบังานที่เราก าลงัท า โดยมีส่วนประกอบ
ต่างๆ ดงัน้ี 

 

 

 

 

 
 

 * ส่วนไวเ้ลือกแทก็ HTML (Tag Selector) : จะแสดงแท็ก HTML ของต าแหน่งที่เราคลิกเลือกบนหน้า
เวบ็ เช่น เราคลิกเลือกตาราง ก็จะแสดงแทก็ <tabel> ซ่ึงจะมีประโยชน์มากในการเลือกจุดแกไ้ข เพราะสามารถ
เลือกจุกหรือแทก็ที่ตอ้งการไดอ้ยา่งแม่นย  า 

 * ขนาดของหนา้จอออกแบบเวบ็เพจ (Window Size) : จะแสดงขนาดของหนา้ต่างออกแบบเวบ็เพจ 

 * เคร่ืองมือปรับการแสดงผลหน้าเวบ็ขณะออกแบบ : Zoom Tool  ใชส้ าหรับยอ่ขยายหน้าเวบ็ให้
เห็นรายละเอียดชดัขึ้น หรือใช ้Hand Tool  เล่ือนดูหนา้เวบ็ในส่วนที่มองไม่เห็น 

 * ขนาดของหนา้เวบ็และเวลาที่ใชใ้นการโหลด : จะแสดงเวลา (โดยประมาณ) ที่ใชใ้นการโหลดหน้า
เวบ็เพจที่เราสร้าง โดยถา้หนา้ที่เราสร้างมีขนาดใหญ่เพราะมีขอ้ความ และรูปภาพจ านวนมาก ก็จะท าให้ตอ้งใช้
เวลาโหลดนาน นอกจากนั้นความเร็วในการโหลดหน้าเวบ็ขึ้นอยูก่บัความเร็วในการโอนยา้ยขอ้มูลของผูใ้ชท้ี่
เช่ือมต่อกบัเครือข่ายอินเทอร์เน็ตดว้ย โดยเร่ิมแรก Dreamweaver จะแสดงเวลาน้ีโดยอา้งอิงกบัโมด็มความเร็ว 
60 k (เราสามารถเปล่ียนค่าน้ีไดใ้นบทการปรับแต่งค่า Dreamweaver) 

  

 
 

ขนาดของหน้าตา่งออกแบบ
เวบ็เพจ (Window Size) 

เคร่ืองมือปรับการแสดงผล
หน้าเวบ็ขณะออกแบบ 

ขนาดหน้าเว็บและ
เวลาท่ีใช้ในการโหลด 

ส่วนไ ว้ เ ลือกแท็ก  HTML 
(Tag Selector) 
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    แทบ็เคร่ืองมอื 
  เป็นเคร่ืองมือที่ใชส้ าหรับสร้างองคป์ระกอบต่างๆ (เราเรียกองคป์ระกอบเหล่าน้ีวา่ออบเจค็) ที่จะน ามา
สร้างหนา้เวบ็เพจ โดยกลุ่มเคร่ืองมือจะถูกเก็บไวเ้ป็นกลุ่มในแทบ็ต่างๆ 7 แทบ็ ดงัน้ี 
 
 

 
 
 
 
 
 
 
 แท็บ Common: เป็นแทบ็ที่รวบรวมเคร่ืองมือต่างๆที่เราเรียกใชง้านบ่อย ไดแ้ก่ การแทรกภาพ การแทรกตาราง 
เป็นตน้ 
 

 
 
 แท็บ Layout: เป็นแทบ็ที่รวบรวมเคร่ืองมือที่ช่วยในการจดัองคป์ระกอบบนหนา้เวบ็ 
 

 
 
 แท็บ Forms: เป็นแทบ็ที่รวบรวมเคร่ืองมือที่ใชใ้นการสร้างแบบฟอร์มสอบถาม และตวัเลือกต่างๆ 
 

 

คลกิเลือกแท็บเคร่ืองมือ 
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 แท็บ Data: เป็นแทบ็ที่รวบรวมเคร่ืองมือส าหรับสร้างแอพพลิเคชัน่ติดต่อกบัฐานขอ้มูล 
 

 
 
 แท็บ Spry: เป็นแทบ็ที่รวบรวมเคร่ืองมือที่ช่วยใหก้ารสร้างฟอร์มไดร้วดเร็วขึ้น 
 

 
 
 แท็บ Text: เป็นแทบ็ที่รวบรวมเคร่ืองมือส าหรับวาง และปรับแต่งตวัอกัษรบนหนา้เวบ็ 
 

 
 
 แท็บ Favorites: เป็นแทบ็ที่รวบรวมเคร่ืองมือที่ใชบ่้อยจากแต่ละกลุ่มเคร่ืองมือมาใส่ในเมนูน้ีได ้
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    องค์ประกอบของหน้าเวบ็เพจ 

ในหน้า เว็บเพจอาจประกอบด้วยองค์ประกอบหลายแบบหลายชนิด เช่น เน้ือความ , รูปภาพ , 
ภาพเคล่ือนไหว  และเสียงประกอบ เป็นตน้  องค์ประกอบเหล่าน้ี เราเรียกว่า ออบเจ็ค (Object)  ดังตวัอยา่ง
ดา้นล่าง   
 
 
 
 
 
 
 
 
 
 
 ในโปรแกรม Dreamweaver CS5น้ี เราสามารถสร้างและใส่ออบเจค็ชนิดต่างๆ ไดอ้ยา่งง่ายดาย ซ่ึงจะอธิบาย
การใชง้านออบเจค็แต่ละชนิดต่อไป 

    ก าหนดคุณสมบัติขององค์ประกอบต่างๆบนหน้าเวบ็ (Property Inspector) 

  เม่ือใดที่เราคลิกเลือกภาพ หรือองคป์ระกอบต่างๆบนหนา้เวบ็ จะปรากฏ Property Inspector ที่แสดงค่า
ต่างๆของภาพให้เราปรับแต่งคุณสมบติัที่เก่ียวขอ้งกับองค์ประกอบนั้นได ้ดังตวัอยา่งเม่ือเราคลิกเลือกที่ภาพ 
Property Inspector ก็จะแสดงคุณสมบติัต่างๆของภาพใหเ้ราปรับแต่งได ้ดงัรูป 
 
 
 
 
 
 
 
 
 

รูปภา
พ 

จดุเช่ือมโยง 

ข้อความ 

Property Inspector แสดงรายละเอียดตา่งๆ 

คลกิภาพ 
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    มุมมองในหน้าต่าง Document 
 

ใน Dreamweaver สารมารถเลือกมุมมองการท างานได ้3 รูปแบบ ให้เราเลือกใชไ้ดต้ามความถนดัของ
เราโดยการคลิกไอคอนทีอ่ยูใ่นทูลบาร์ ดงัน้ี 

 
 
Show Code View 

คลิกที่  จะปรากฏมุมมองแสดงโคด้ HTML หรือสคลิปตต่์างๆ ของหนา้เวบ็เพจที่เราก าลงั
ท างานอยู ่ซ่ึงเหมาะส าหรับผูส้ร้างเวบ็ไซตท์ี่สามารถเขียนโคด้ HTML หรือสคริปตต่์างๆได ้

 
 

 

 
 
 

คลกิ   Code 

16



 

 

 
Show Code and Design View 

คลิกที่  จะแสดงทั้งโคด้พร้อมทั้งหนา้เวบ็เพจที่เราก าลงัท างานอยู ่เหมาะส าหรับผูใ้ชท้ี่
ตอ้งการดูการแสดงผลโคด้ของหนา้เวบ็เพจที่ใชใ้นการออกแบบ 

 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

คลกิ  Split 
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Show Design View 

คลิกที่  ส าหรับแสดงหนา้จอออกแบบเวบ็เพจที่ไม่มีการแสดงโคด้ต่างๆ เหมาะส าหรับผูท้ี่
สร้างเว็บไซต์ที่ไม่รู้เก่ียวกับการสร้างเว็บไซต์ด้วยภาษา HTML หรือสคริปต์ต่างๆ เพราะสามารถจัด
องคป์ระกอบของภาพและขอ้ความบนหนา้เวบ็น้ีไดอ้ยา่งง่ายๆ 

 
 
 

 

คลกิ  Design 
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   กลุ่มหน้าต่างพาเนล (Panel Group) 

 ในโปรแกรม Dreamweaver มีหนา้ต่างพาเนลต่างๆที่ช่วยเพิม่ความสามารถในการจดัการ และออกแบบ
หนา้เวบ็ของเราได ้ซ่ึงแต่ละพาเนลจะมีความสามารถในการจดัหนา้เวบ็ไดไ้ม่เหมือนกนั เราสามารถเรียกเปิด
พาเนลไดจ้ากเมนูค  าสัง่ Window > และเลือกพาเนลที่ตอ้งการดงัน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

เลือกเมนคู าสัง่ Window > 
เลือกพาเนลท่ีต้องการ 

กลุม่หน้าต่างพาเนลท่ีเรา
เลือกเปิดขึน้มาใช้งาน 
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 พาเนล CSS 

 พาเนล CSS เป็นพาเนลที่ใชใ้นการก าหนดรูปแบบการ
แสดงหนา้เวบ็ พาเนลน้ีประกอบไปดว้ยแทบ็ CSS Styles 

และแทบ็ AP Elements 
 
 
 

 พาเนล Application 
 พาเนล Application เป็นพาเนลที่เก่ียวกบัการเช่ือมโยง
เวบ็ไซตข์องเรากบัฐานขอ้มูลบนเคร่ืองเซิร์ฟเวอร์ โดย
พาเนลประกอบไปดว้ยแทบ็ Database, แทบ็ Bindings, แทบ็ 
Sever Behaviors และแทบ็ Components 
 
 
 
 
 
 

 พาเนล  Tag  Inspector 
 พาเนล Tag จะรวบรวมการใชง้านแทก็ค าสัง่ของ CSS 
(Cascade Style Sheet) ทั้งหมด ซ่ึงในพาเนลน้ีจะมี
ส่วนประกอบทั้งหมด 2 แทบ็ คือ แทบ็ Attributes และแทบ็ 
Behaviors 
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 พาเนล Files 

 พาเนล Files เป็นพาเนลที่บอกวา่ภายในเวป็ไซตข์องเรามี
เวบ็เพจ และโฟลเดอร์อะไรเก็บอยูบ่า้ง โดยจะประกอบดว้ย
แทบ็ Fikes, แทบ็ Assets และแทบ็ Snippets ที่อ  านวยความ
สะดวกใหก้บัคนที่สร้างเวบ็เพจในการแกไ้ขโคด้ HTML และ
การแทรกภาษาสคริปตต่์างๆ  
 

    การพับเก็บกรอบหน้าต่างพาเนล 
หากไม่จ าเป็นตอ้งปรับค่าจากพาเนล เราสามารถพบัเก็บกรอบหนา้ต่างพาเนล เพือ่เพิม่พื้นที่ในการตกแต่ง

เวบ็เพจไดส้ะดวกขึ้น และเม่ือตอ้งการท างานก าหนดค่าในพาเนล ใหเ้ปิดหนา้ต่างกลบัมาดงัเดิมได ้ดงัน้ี 
 
 

 
 
 
 
 

 
 

 
 

 
 
 
 
 
 
 

 

คลกิเพ่ือเก็บกรอบหน้าตา่งพาเนล 

คลกิเพ่ือแสดงกรอบหน้าต่างพาเนล 
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   ย้ายหน้าต่างพาเนลเข้า – ออก 
 หากตอ้งการน าหนา้ต่างพาเนลมาอยูใ่กลพ้ื้นที่การท างานในเวบ็เพจ ก็สามารถดึงพาเนลออกมาจาก

กรอบหนา้ต่างได ้และเม่ือใชง้านเสร็จแลว้ก็ดึงไปเก็บที่เดิม เพือ่ไม่ใหเ้กะกะในพื้นที่ท  างาน ดงัน้ี 
 

      
 
 

 
 

ล า ก เ ม า ส์ ท่ี แ ถ บ
พาเนลไปวางต าแหน่งท่ี
ต้องการจะใช้งาน 

ลากเมาส์ท่ีแถบ
พาเนล จากนัน้ปลอ่ย
เมาส์ในต าแหน่งท่ี
ปรากฏแถบสีทึบ เล่ือน
พาเนลเข้ามาเก็บใน
กรอบหน้าตา่งพาเนล 
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   การสร้างเวบ็ไซต์ 
เร่ิมต้นสร้างเวบ็ไซต์ 

ในการสร้างเวบ็ไซตด์ว้ยโปรแกรม Dreamweaver เราจะเร่ิมจากการก าหนดโครงร่างของเวบ็ และสร้าง
โฟลเดอร์และไฟลต่์างๆ ที่ประกอบกนัเป็นเวบ็ไซตข์องราก่อน ดงัน้ี 
 
ก าหนดโครงร่างของเว็บ 

 ก่อนที่เราจะสร้างเวบ็ไซตข์ึ้นมา ขอแนะน าใหเ้ร่ิมออกแบบโครงร่างคร่าวๆของเวบ็ไซตน์ั้นก่อน เพือ่
ไม่ก่อใหเ้กิดความสบัสนที่อาจตามมาในภายหลงั โดยเวบ็ไซตท์ี่ประกอบดว้ยเวบ็เพจหลายหนา้ จะนิยมจดัเก็บ
ไฟลเ์วบ็เพจไวใ้นโฟลเดอร์แยกตามหวัขอ้ต่างๆ 

 ดงัตวัอยา่ง ถา้เราตอ้งการจดัท าเวบ็ไซตข์ายเคร่ืองประดบั ก็อาจสร้างโฟลเดอร์ช่ือ “jewelry” เป็น
โฟลเดอร์ที่รวมเวบ็เพจ และไฟลต่์างๆ ที่ใชไ้วท้ั้งหมด โดยในโฟลเดอร์น้ีจะประกอบดว้ยหลายโฟลเดอร์ยอ่ย
ส าหรับแยกเก็บไฟลต่์างๆ ที่ประกอบกนัเป็นเวบ็ไซต ์เช่น โฟลเดอร์ ช่ือ “home” “new” “catalog” “about” 
“contact” และจะเก็บไฟล ์.html ที่ใช ้ส่วนโฟลเดอร์ “images” จะเก็บไฟลรู์ปภาพและมลัติมีเดียที่ใชใ้นเวบ็ไซต ์
 

    ก าหนดเว็บไซต์ใหม่ใน Dreamweaver 
 เราจะเร่ิมตน้โดยการก าหนดเวบ็ไซตใ์หม่ในโปรแกรม Dreamweaver โดยมี 2 วิธีที่ท  าได ้วธีิแรกจะใช้

วซิาร์ดช่วย และวธีิที่สองเราจะก าหนดค่าต่างๆ เอง 
 วิธีที่ 1 สร้างเว็บไซต์แบบใช้วิซาร์ด  
 โดย Dreamweaver จะให้เราก าหนดเพยีงขอ้มูลพืน้ฐานเก่ียวกบัการสร้างเวบ็ไซตใ์หม่ เช่น ตอ้งการ
สร้างเวบ็ไซตก์บัเซิร์ฟเวอร์แบบไหน, ตอ้งการสร้างเวบ็ไซตค์นเดียว หรือท างานร่วมกนัเป็นทีม เป็นตน้ จากนั้น 
Dreamweaver จะช่วยก าหนดรายละเอียดเพิม่เติมใหท้ั้งหมด นบัเป็นวธีิที่สะดวกและรวดเร็วดงัน้ี 
 
 
 
 
 
 
 
 
 

เลือกค าสัง่ Site > 
Manage Sites เพ่ือ
เข้าสูก่ารสร้างเว็บไซต์
ของเรา 
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คลกิปุ่ ม New แล้วเลือกค าสัง่ Site 
เพ่ือสร้างเวบ็ไซต์ใหม่ 

  ตัง้ช่ือไซต ์
       Site Name………………………. 
       ก าหนดพืน้ท่ีจดัเก็บข้อมลู 
       Local Site Folder……………… 
 

 โปรแกรมจะแสดงรายการของ  Local 
Site  ท่ีเราก าหนดคา่ไว้  จากนัน้คลกิท่ีปุ่ ม 
Done  เพ่ือเข้าไปสร้างเว็บเพจตอ่ไป 
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    สร้างโฟลเดอร์ใหม่ในเว็บไซต์ 

 ในกรณีที่ตอ้งการสร้างโฟลเดอร์ยอ่ยใตโ้ฟลเดอร์ที่เก็บเวบ็ไซตข์องเรา เพือ่แยกเก็บขอ้มูล และหนา้เวบ็
ใหเ้ป็นหมวดหมู่ ให้เราคลิกเมาส์ปุ่ มขวาที่โฟลเดอร์ Site แลว้เลือก New Folder จะปรากฏไฟลใ์หม่ในรายการ 
ใหเ้ราตั้งช่ือโฟลเดอร์ใหม่น้ีแลว้กดปุ่ ม <Enter> ดงัน้ี 
 

         
 
 
 
 
 
 
               
 
 
 
เปลี่ยนช่ือไฟล์และโฟลเดอร์ 
 การเปล่ียนช่ือไฟล ์และโฟลเดอร์ที่อยูภ่ายในเวบ็ไซตข์องเราจะช่วยส่ือความหมายใหต้รงกบัเน้ือหาโดย
ใหเ้ราคลิกที่ไฟล ์หรือโฟลเดอร์ที่ตอ้งการจะเปล่ียนช่ือ คลิกซ ้ าอีกคร้ัง แลว้พมิพช่ื์อไฟล/์โฟลเดอร์ใหม่ จากนั้น
กดปุ่ ม <Enter>  
        

คลกิเมาส์ปุ่ มขวาท่ีโฟลเดอร์ Site แล้วเลือก New 
Folder 

ตัง้ช่ือโฟลเดอร์ใหม่แล้วกดปุ่ ม <Enter> 
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   การสร้างหน้าเวบ็เพจใหม่ 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

เลือกค าสัง่ 
File > New…  

คลกิรายการ 
Blank Page > 
HTML แล้วคลกิ
ปุ่ ม Create  

แสดงหน้าเวบ็ใหม่  
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     หน้าเว็บรูปแบบต่างๆ ที่น ามาใช้ได้ 

 นอกจากการสร้างหนา้เวบ็เปล่า ที่หนา้ต่าง New Document จะแสดงหนา้เวบ็แต่ละแบบใหเ้ราเลือกใช้
ไดเ้ลย ดงัน้ี 

Blank Page สร้างหนา้เวบ็เปล่า โดยสามารถก าหนดชนิดของหนา้เวบ็ที่เราจะใชง้านได ้เช่น หนา้
เวบ็ HTML, เทมเพลต, ไลบราร่ี, XSLT, ActionScript, CSS, JavaScript และ XML 
หรือหนา้เวบ็แบบไดนามิกที่สนบัสนุนการท างานดว้ยภาษาที่ใชบ้นเวบ็เซิร์ฟเวอร์ เช่น 
ASP, ColdFusion, JSP และ PHP เป็นตน้ 

Blank Template สร้างหนา้เทมเพลต เพือ่ใชเ้ป็นตน้แบบในการสร้างหนา้เวบ็ 

Page from Template สร้างหนา้เวบ็โดยใชต้น้แบบ 

Page from Sample สร้างหนา้เวบ็จากตน้แบบที่ Dreamweaver มีให ้

Other สร้างหนา้เวบ็แบบอ่ืนๆ เช่น หนา้เวบ็ที่มีการใชภ้าษา C#, VBScript หรือ เทก็ซ์ไฟล ์
เป็นตน้ 
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    รายละเอียดหน้าเว็บ 

 การก าหนดรายละเอียดของหนา้เวบ็ โดยเลือกค าสัง่ Modify > Page Properties จะพบกบัหนา้ต่าง Page 
Properties ดงัน้ี 

 

  

 

 

 

 

หนา้ต่าง Page Properties จะแบ่งรายละเอียดต่างๆของหนา้เวบ็ที่ปรับแต่งไดอ้อกเป็น 5 หมวด ดงัน้ี 

หมวด Appearance ก าหนดหน้าตาของส่วนประกอบต่างๆ บนหน้าเว็บ 

 Page font   ก าหนดรูปแบบของตวัอกัษรที่ใชใ้นเวบ็เพจ 

 Size  ก าหนดขนาดของรูปแบบตวัอกัษรที่ใช ้

 Text color  ก าหนดสีใหก้บัตวัอกัษร 

 Background color ก าหนดสีที่ตอ้งการใหเ้ป็นพื้นหลงัของหนา้เวบ็ 

 Background Image ก าหนดภาพที่ใชเ้ป็นฉากหลงัของหนา้เวบ็ 

 Repeat  ก าหนดการแสดงซ ้ าของภาพพื้นหลงั 

 Left Margin ก าหนดระยะขอบซา้ยของหนา้เวบ็ 

 Right  Margin ก าหนดระยะขอบขวาของหนา้เวบ็ 

 Top Margin ก าหนดระยะขอบบนของหนา้เวบ็ 

 Bottom  Margin ก าหนดระยะขอบล่างของหนา้เวบ็ 
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หมวด Links ก าหนดแสดงลงิค์บนหน้าเว็บ 

 

 Link font   ก าหนดรูปแบบของตวัอกัษรของลิงค ์

 Size  ก าหนดขนาดของรูปแบบตวัอกัษรของลิงค ์

 Links color  ก าหนดสีของลิงค ์

 Rollover links ก าหนดสีของลิงคเ์ม่ือใชเ้มาส์ไปช้ี 

 Visited links ก าหนดสีของลิงคเ์ม่ือถูกคลิกไปแลว้ 

 Active links  ก าหนดสีของลิงคเ์ม่ือก าลงัถูกคลิก 

 Underline style ก าหนดรูปแบบการขีดเสน้ใตใ้หก้บัลิงค ์
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หมวด Headings ก าหนดคุณสมบัติหัวของเว็บเพจ 

 

 Heading font ก าหนดรูปแบบของตวัอกัษรใหห้วัขอ้ที่แสดงบนหนา้เวบ็ 

 Heading  1-6 ก าหนดขนาดของรูปแบบตวัอกัษรที่ใชส้ร้างหวัขอ้บนหนา้เวบ็ 

 

หมวด Title/Encoding ก าหนดช่ือให้ส่วนหัวเร่ืองของเว็บเพจ และก าหนดชุดตัวอักษรทีใ่ช้ 

 

 Title  ก าหนดส่วนช่ือหวัเร่ืองใหเ้วบ็เพจ 

 Document type ก าหนดประเภทของเวบ็เพจ 

 Encoding ก าหนดรูปแบบภาษาของตวัอกัษรที่ใชใ้นเวบ็เพจ ส าหรับการแปลงตวัอกัษร เพือ่ให้
เป็นภาษามาตรฐานที่ตอ้งการ ถา้เราตอ้งการใชภ้าษาไทยใหเ้ลือกไทย (Windows) 
หรือ Unicode (UTF-8)  
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หมวด Tracing Image ก าหนดคุณสมบัติหัวของภาพที่จะใช้เป็นแบบในการสร้างหน้าเว็บเพจ 

 

 Tracing Image เลือกไฟลภ์าพที่จะใช ้

 Image Transparency ก าหนดค่าความโปร่งใสของภาพ โดยภาพจะเป็นแบบสีจางๆ ดา้นหลงั ช่วย
ใหเ้ราเห็นต าแหน่งวางภาพ วางขอ้ความที่ถูกตอ้ง 

     การเพิ่มเนื้อหาในหน้าเว็บ 

 ขั้นตอนที่ 1 ก าหนดหัวเร่ืองบนหน้าเว็บ 
 เราสามารถใส่หวัเร่ืองบนหนา้เวบ็ หรือที่นิยมเรียกวา่ไตเต้ิล (Title) ไดท้ี่ช่อง Title บนแถบเคร่ืองมือ 
ดงัน้ี 

 
 
  
 
 
 
 
 
 
 
 
 

ในช่อง Title ใสช่ื่อหวัเร่ืองท่ีเราต้องการบนหน้าเวบ็ของ
เรา  
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ขั้นตอนที่ 2 แทรกภาพในหน้าเว็บเพจ 

 แทรกภาพลงหนา้เวบ็เพจ มีวธีิการดงัน้ี 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 
 

เลือกต าแหน่งของ
ภาพท่ีต้องการจะวาง
บนหน้าเวบ็แล้วเลือก

เคร่ืองมือ  
(image) แท็บ 
Common 

เลือกภาพท่ีต้องการ 

คลกิ  เพ่ือตกลงเลือกภาพ  
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 โปรแกรมจะแสดงคุณสมบติัของวตัถุรูปภาพให้เราสามารถปรับแต่งค่าต่าง ๆไดท้ั้งหมด เช่นการปรับ
ขนาดรูปภาพ  การท า Map Images  การเช่ือมโยง  การก าหนดใหมี้ค  าอธิบายรูปภาพ 
 
 
 

 
 

เขียนค าอธิบายรูปภาพ 
และคลกิ  

33



 

 

 ขั้นตอนที่ 3 ใส่ข้อความบนหน้าเว็บ 
 การใส่ขอ้ความบนหนา้เวบ็คลา้ยกบัการพมิพเ์อกสารในโปรแกรม Word โดยให้เราคลิกบนพื้นที่
ท  างาน แลว้พมิพข์อ้ความบนหนา้เวบ็ไดเ้ลย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 การกดปุ่ ม <Enter> จะเป็นการขึ้นยอ่หนา้ใหม่ และขอ้ความในแต่ละยอ่หนา้จะถูกจดัใหเ้ตม็หนา้ต่าง 
 ในกรณีที่เราตอ้งการขึ้นบรรทดัใหม่ในยอ่หนา้เดิม ใหก้ด <Shift + Enter> แทน (หรือคลิกแทบ็ Text 
และคลิกปุ่ ม  ก็ได)้  
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   บันทึกไฟล์เว็บเพจที่สร้าง 

 หลงัจากที่เราสร้างเวบ็เพจไดต้ามตอ้งการแลว้ ใหท้  าการบนัทึกไฟลเ์วบ็เพจ โดยเลือกค าสัง่ File > Save 
เน่ืองจากเรายงัไม่เคยบนัทึกไฟลน้ี์มาก่อนโปรแกรม Dreamweaver จะให้เราระบุช่ือไฟลใ์หม่ดว้ย เช่น 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 จากนั้นเม่ือใดที่เราท าการแกไ้ขหนา้เวบ็ และตอ้งการบนัทึกการเปล่ียนแปลง ก็ใหเ้ลือกค าสัง่  File > 
Save เพือ่บนัทึกหนา้เวบ็แทนที่ไฟลเ์ดิมที่บนัทึกไวไ้ด ้แต่ถา้ตอ้งการบนัทึกไฟลน้ี์ไวท้ี่ต  าแหน่งใหม่ หรือบนัทึก
เป็นไฟลใ์หม่ ใหเ้ลือกค าสัง่ File > Save As… และก าหนดต าแหน่งเก็บและช่ือไฟลไ์ด ้

เลือก
ค าสัง่  File 
> Save  

เลือกพืน้ท่ีจดัเก็บไฟล์   หากมีการก าหนด Local Site ไว้โปรแกรมจะแสดงโฟลเดอร์ท่ีก าหนดไว้ให้ทนัที 

  ตัง้ช่ือไฟล์  โดยตัง้ช่ือเป็น
ภาษาองักฤษห้ามเว้นวรรค และ
สญัลกัษณ์ทางคณิตศาสตร์ 

คลกิปุ่ ม    
เพ่ือบนัทึกไฟล์ 
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    การแก้ไขข้อผิดพลาดด้วยพาเนล History 

  ในกรณีที่เราตอ้งการยกเลิกส่ิงที่เราไดก้ระท าไปแลว้ เราสามารถกระท าไดโ้ดยเปิดใชพ้าเนล History 
ซ่ึงพาเนลน้ีจะช่วยใหเ้ราดู, ยกเลิก, หรือท าซ ้ าการกระท าใด ๆ ที่ไดก้ระท าไปแลว้ 
 การเปิดใชพ้าเนล   History   จะกระท าไดโ้ดยเลือกเมนูค  าสัง่ Windows เลือกค าสัง่ History 
 
 
 
 
 
 
 
 
 
 

 
 

    การเปิดดูหน้าเว็บที่สร้างบนบราวเซอร์ 

 เม่ือเราบนัทึกเวบ็เพจที่เราสร้างเสร็จเรียบร้อยแลว้ ให้เปิดดูหนา้เวบ็ไดบ้ราวเซอร์ โดยเลือกค าสัง่  
File > Preview in Browser > ช่ือบราวเซอร์ที่ติดตั้งไวใ้นเคร่ือง (หรือกดคียล์ดั <F12>)  

 

 

 

 

 

 

เลือกค าสัง่ File > 
Preview in Browser > 
Iexplorer  หรือ กด <F12>  

แถบเล่ือน 

ขัน้ตอนการท างาน 

บนัทึกขัน้ตอนการท างาน 

คดัลอกขัน้ตอนการท างาน ท าซ า้ขัน้ตอนการท างาน 
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แสดงหน้าเวบ็ท่ี
เราสร้างบราวเซอร์ 
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การใส่ข้อความและรูปภาพลงในเวบ็เพจ 

มาตรฐานการเรียนรู้/ ตัวช้ีวดั 

กลุ่มสาระการงานอาชีพและเทคโนโลย ี

สาระที ่ ๒ การออกแบบและเทคโนโลยี 

        มาตรฐาน ง ๒.๑ เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ี ออกแบบและสร้างส่ิงของเคร่ืองใช ้

หรือวธีิการ ตามกระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรค ์ เลือกใชเ้ทคโนโลยใีนทางสร้างสรรค์

ต่อชีวติ  สงัคม   ส่ิงแวดลอ้ม  และมีส่วนร่วมในการจดัการเทคโนโลยทีี่ย ัง่ยนื 

ตัวช้ีวดั 
        ๑.ง ๒.๑/๓ สร้างและพฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลยอียา่งปลอดภยัโดย

ถ่ายทอดความคิดเป็นภาพฉายและแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  หรือถ่ายทอดความคิดของ

วธีิการเป็นแบบจ าลองความคิดและการรายงานผลโดยใชซ้อฟแวร์ช่วยในการออกแบบหรือน าเสนอผลงาน 

สาระส าคญั 
       เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ี ออกแบบและสร้างส่ิงของเคร่ืองใช ้หรือวธีิการ สร้าง

และพฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลยอียา่งปลอดภยัโดยถ่ายทอดความคิดเป็น

ภาพฉายและแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน   

สาระการเรียนรู้ 

- ความรู้ 
๑.เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลยี 
๒.เขา้ใจออกแบบและสร้างส่ิงของเคร่ืองใชห้รือวธีิการสร้างและพฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตาม

กระบวนการเทคโนโลยอียา่งปลอดภยั 
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 - ทกัษะ / กระบวนการ 

    ๑.มีกระบวนการออกแบบและสร้างส่ิงของเคร่ืองใช ้

 ๒.ทกัษะการออกแบบหรือน าเสนอผลงาน 

- คุณลกัษณะทีพ่งึประสงค์ 

   ๑.มีวนิยั 

   ๒.ใฝ่เรียนรู้ 

   ๓.มุ่งมัน่ในการทางานรู้เรียนรู้ 
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 การก าหนด Encoding แสดงข้อความบนเว็บเพจเป็นภาษาไทย 

 Encoding เป็นการก าหนดรูปแบบการแสดงภาษาบนเวบ็เพจ เม่ือเราแสดงเวบ็เพจน้ีบนบราวเซอร์ ก็
จะแสดงตวัอกัษรเป็นภาษาในรูปแบบที่ก  าหนดไวอ้ตัโนมติั ปัจจุบนัการก าหนดภาษาไทยบนเวบ็เพจจะนิยม
ใชอ้ยู ่2 รูปแบบ คือ 

Thai (Windows) เป็นมาตรฐานภาษาไทยของ Windows โดยใชค้่ารหสัตวัอกัษรเป็น Windows-874 

Unicode (UTF-8) เป็นมาตรฐานที่เขา้รหสัแบบไบนาร่ี Unicode ซ่ึงเก็บอกัษรได ้34, 168 ตวั และเป็น
ภาษาต่างๆ ไดถึ้ง 24 ภาษา รวมทั้งภาษาไทยดว้ย การก าหนดจะใชค้่า
รหสัตวัอกัษรเป็น UTF-8 

 ปัจจุบนัการท าเวบ็เพจจะนิยมก าหนดเป็น UTF-8 เพราะรองรับการท างานขา้มระบบ รวมถึง
แสดงผลตวัอกัษรบนอุปกรณ์แบบพกพา ปาลม์ พอ็กเก็ตพซีี ไอโฟน และสมาร์ทโฟนไดอ้ยา่งถูกตอ้ง 

 วธีิการก าหนด Encoding บนหนา้เวบ็ ดงัน้ี 

 

 

 

 

 

 

 

 

เลือกค ำสัง่  Modify 
>Page Properties… 
เพ่ือเลือกรูปแบบกำร
เข้ำรหสัตวัอกัษร 

การใส่ข้อความและรูปภาพลงในเวบ็เพจ 
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คลกิเลือกท่ีหวัข้อ 
Title/Encoding 

 

 

 

 

 
 
 
 
 
 
 

 การพมิพ์ข้อความ  

 เราสามารถพมิพข์อ้ความต่าง ๆ ลงไปในหนา้เวบ็เพจไดโ้ดยตรง  โดยเน้ือความที่พิมพม์กัจะถูกแบ่ง
ออกเป็นส่วน ๆ  เรียกวา่ ย่อหน้า (Paragraph)  ซ่ึงแต่ละยอ่หนา้อาจมีเพียงบรรทดัเดียวหรือหลายๆ บรรทดั
ก็ได ้   โดยการกดปุ่ ม Enter เม่ือจบบรรทดัหมายถึงการจบยอ่หนา้นั้นและขึ้นยอ่หนา้ใหม่   

   วธีิการพมิพ์ข้อความ   
วธีิการพมิพเ์น้ือความจะตอ้งอยูใ่น  มุมมองออกแบบ  (Design View) โดยเลือกค าสัง่     

View เลือก Design   
1. เล่ือนเคอร์เซอร์ไปยงัต าแหน่งที่ตอ้งการพมิพข์อ้ความ 
2. กดปุ่ มเปล่ียนภาษาไทย/องักฤษ  ( ปุ่ ม Tile) 
3. พมิพข์อ้ความที่ตอ้งการ  เราสามารถพมิพข์อ้ความต่าง ๆ  ไปจนสุดขอบขวาของหนา้เวบ็เพจ  

และเม่ือเราพมิพต่์อไป  ขอ้ความส่วนที่เกินนั้นจะถูกตดัขึ้นบรรทดัใหม่เองโดยอตัโนมติั  ดงันั้น
เราจึงสามารถพมิพข์อ้ความไปไดเ้ร่ือย ๆ จนจบยอ่หนา้ 

4. หากตอ้งการขึ้นยอ่หนา้ใหม่ใหก้ดปุ่ ม Enter   

 

 

เลือกรูปแบบกำร
เข้ำรหสัตวัอกัษร 

Thai (Windows) 
Unicode (UTF-8) 

คลกิ  
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 การเลอืกข้อความ 

 ในการท างานของโปรแกรม Adobe Dreamweaver CS3 น้ีการเลือกขอ้ความที่จะท างานก็เหมือนกบั
การเลือกขอ้ความทัว่ๆ ไป คือจะตอ้งมีการเลือกขอ้ความหรือ ท าแถบสีด าคลุมขอ้ความที่ตอ้งการก่อนท าการ
เปล่ียนแปลงรายละเอียดต่าง ๆ โดยมีวธีิการดงัน้ี 

   การใช้เมาส์   
1.   เล่ือนเมาส์ไปยงัต าแหน่งที่ตอ้งการเลือกขอ้ความ   
2.   กดปุ่ มเมาส์ทางซา้ยคา้งไว ้ แลว้ลากไปยงัต าแหน่งสุดทา้ยของขอ้ความที่ตอ้งการเลือก   
3.   ปล่อยเมาส์ก็จะไดแ้ถบสีด าเลือกขอ้ความที่ตอ้งการ   
  

 

 

  การใช้แป้นพมิพ์ 

1.   เล่ือนเคอร์เซอร์ไปยงัต าแหน่งตน้ขอ้ความที่จะเลือก 
2.   กดปุ่ ม  Shift คา้งไว ้พร้อมกดปุ่ มลูกศรบนแป้นพมิพ ์เพือ่เล่ือนเคอร์เซอร์ไปยงั   ต  าแหน่ง
สุดทา้ยของขอ้ความ 
3.   ปล่อยปุ่ มทั้งสองก็จะไดแ้ถบสีด าเลือกขอ้ความที่ตอ้งการ 
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 การเลอืกข้อความยาว ๆ  เราสามารถเลือกขอ้ความยาว ๆ  ไดโ้ดยการใชว้ิธีลดัที่คลิกเมาส์เพียงสอง
คร้ัง  ซ่ึงไม่ตอ้งเสียเวลาในการดรากส์เมาส์ยาว ๆ  โดยท าตามขั้นตอนดงัน้ี   

1.   คลิกเมาส์เพือ่วางเคอร์เซอร์ที่ตน้ขอ้ความที่ตอ้งการ 
2.   กดปุ่ ม  Shift คา้งไว ้  
3.   คลิกเคอร์เซอร์ที่ต  าแหน่งสุดทา้ยของขอ้ความ  ก็จะไดข้อ้ความที่เลือก 
 

 
 

 การเลอืกทลีะค าหรือทีละวรรค 
      ดบัเบิ้ลคลิกที่ค  าหรือวรรคนั้น  ก็จะสามารถเลือกค าไดโ้ดยไม่ตอ้งดรากส์เมาส์เลือกทีละค าหรือที
ละวรรค  
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 การเลอืกข้อความทั้งหมด 
การเลือกขอ้ความทั้งหมด เราสามารถใชค้  าสัง่บนเมนูบาร์ คือ  เลือกเมนูค  าสัง่  Edit  เลือกค าสัง่   
Select  All   จะไดแ้ถบสีด าคลุมขอ้ความทั้งหมดในแฟ้มขอ้มูล 

 

 

 การเลอืกข้อความโดยใช้  Selection  bar 
Selection bar เป็นแถบวา่งๆ ที่อยูด่า้นซา้ยสุดของหนา้ต่าง document เม่ือน าเมาส์มาอยูบ่ริเวณ 

Selection bar เมาส์พอยน์เตอร์จะเปล่ียนเป็นรูป   
 

 
 

Selection bar 
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 เลือกทลีะบรรทัด 
คลิกที่  Selection bar ในตน้บรรทดัที่ตอ้งการเลือก 

 

 
 
 

 เลือกทลีะหลาย ๆ  บรรทัด  
       คลิกที่  Selection bar ในตน้บรรทดันั้น แลว้ลากเมาส์ขึ้นหรือลงใน Selection bar   
 

 

 การยกเลกิส่วนทีเ่ลอืกไว้   
คลิกที่ต  าแหน่งใด ๆ  บนพื้นที่วา่งที่ไม่ใช่บริเวณแถบสีด า  ซ่ึงจะท าใหแ้ถบสีด าที่เลือกไวห้ายไป   
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 การจดัรูปแบบตัวอกัษร    

         เม่ือเราท าการเลือกขอ้ความตามที่ตอ้งการได้แล้วถ้าตอ้งการเปล่ียนลักษณะของตวัอักษร  เรา
สามารถท าไดโ้ดยใชก้ารก าหนดค่าในส่วนของ พาเนล  Properties  ที่อยูด่า้นล่างของโปรแกรม เช่น  การ
เปล่ียนแบบอกัษร  , ขนาดตวัอกัษร , สีตวัอกัษร  ,  ก าหนดตวัหนาและตวัเอียงให้กบัตวัอกัษร  ก็สามารถ
เปล่ียนไดจ้ากพาเนลตวัอกัษรไดท้นัที ซ่ึงมีรายละเอียดของแต่ละไอคอนดงัต่อไปน้ี   

 

                                                                                                                                                                                                                                                                                                   

 

 

 

 

 

 

 

 

 

เลือกรูปแบบหวัข้อ
ของข้อควำม 

เลือกสไตล์ท่ีเรำเคยก ำหนด
ให้กบัตวัอกัษร หรือสร้ำงสไตล์
ใหมจ่ำกหน้ำต่ำง CSS Style 

เปิดแถบพำเนล CSS 

ตวัหน
ำ 
ตวัเอียง 

จดัต ำแหน่งข้อควำม 

จดัย่อหน้ำของข้อควำม 

ใส ่Bullet หรือตวัเลขก ำกับในแต่
ละบรรทดัของข้อควำม 

คลกิเมำส์เลือกสีให้กบั
ตวัอกัษร 

ขนำดตวัอกัษร 

เลือกรูปแบบตวัอกัษรท่ีมี
อยู่ หรือเพิม่/ลบรูปแบบ
ตวัอกัษร โดยเลือกท่ี Edit 
Font List… 
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   การเปลี่ยนสีตัวอักษร 

 ในการเปล่ียนลกัษณะของแบบอกัษร หรือสีตวัอกัษรของการใชโ้ปรแกรม Adobe Dreamweaver 
CS3 หรือการสร้างโฮมเพจทัว่ไป จะตอ้งเขียนเป็นรหัสสี  เช่น  #FF9900  จะไดเ้ป็นสีเขียว  , #990000  เป็น
สีแดงเขม้ เป็นตน้  ซ่ึงรหัสสีน้ีเม่ือเราเลือกสีใดจะปรากฏในช่องส่ีเหล่ียมดา้นขา้งและจะปรากฏในมุมมอง 
Code View  ดว้ย   หรือจะเลือกใชค้  าสัง่จากเมนูบาร์ก็ไดเ้ช่นกนั ค  าสัง่ คือ Text  เลือกค าสัง่  Color… 
 
 
 
 
 
 
 

   การเปลี่ยนรูปแบบตัวอักษร 

 ในการเปล่ียนลกัษณะของแบบอกัษร สามารถท าไดโ้ดยเลือกขอ้ความที่ตอ้งการแลว้เลือก   
ลกัษณะรูปแบบตวัอกัษรที่ตอ้งการ  หรือจะเลือกใชค้  าสัง่จากเมนูบาร์ก็ไดเ้ช่นกนั ค  าสั่ง คือ Text เลือกค าสั่ง 
Font   
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   การเปลี่ยนขนาดตัวอักษร 

 การก าหนดขนาดตวัอกัษรใน  Dreamweaver CS5 มีความยดืหยุน่มากขึ้นดว้ยคุณสมบติัของ CSS 
คือสามารถระบุหน่วยซ่ึงจะท าใหไ้ดข้นาดที่แน่นอน 

หากตอ้งการเปล่ียนขนาดของแบบอกัษรในรูปแบบ  HTML     สามารถท าไดโ้ดย   
เลือกค าสัง่ Edit >> Preferences คลิกที่กลุ่ม General และคลิก      ยกเลิกที่               
                            ในก าหนดรูปแบบแทน CSS 
  

 
 
 
 
 
 

   การเปลี่ยนลักษณะของแบบอักษร 
 ในการเปล่ียนลักษณะของแบบอักษร      สามารถท าได้โดยเลือกขอ้ความที่ตอ้งการแล้วเลือก
ลกัษณะตวัอกัษรที่ตอ้งการ เช่น  ตวัหนา ตวัเอียง หรือ ตวัขีดเส้นใต ้ หรือจะเลือกใชค้  าสั่งจากเมนูบาร์ก็ได้
เช่นกนั ค  าสัง่ คือ Text เลือกค าสัง่ Style   
 

 

 

 

 

 

 

 

ก ำหนดรูปแบบเป็น
แบบ HTML 

ก ำหนดรูปแบบเป็น
แบบ  CSS 
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 การจดัย่อหน้า 
 การจดัวางข้อความในย่อหน้า 

         การจดัวางขอ้ความสามารถท าไดห้ลายรูปแบบ  เพือ่สะดวกในการจดัขอ้ความใหอ้ยูใ่นต าแหน่ง
ที่สวยงามและเป็นระเบียบ  สามารถท าได ้ 2 วธีิ 
วิธีที่  1 
1. เลือกยอ่หนา้ที่ตอ้งการจะจดัรูปแบบ หรือคลิกเมาส์ที่ยอ่หนา้นั้น   
2. คลิกไอคอนการจดัยอ่หนา้บนพาเนล  Properties   

 
 
 
 
 
 

 
 
 วิธีที่  2   เลือกเมนูค  าสัง่  Format  เลือกค าสัง่ Align   
 

 
 

 

 

 

ชิดขวำ 

ชิดขอบ 

กึ่งกลำง 

ชิดซ้ำย 
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 การจดัระยะเยือ้ง  (Indent)  ของย่อหน้า 
             เป็นการจดัใหย้อ่หนา้นั้นห่างจากขอบของหนา้เอกสาร  โดยยอ่หน้านั้นจะถูกจดัให้ทั้งซ้ายและขวา
ห่างจากขอบเท่า ๆ  กนั ซ่ึงในแต่ละย่อหน้า  เราสามารถใช้ค  าสั่งน้ีไดห้ลายคร้ังเพื่อให้เยื้องจนไดร้ะยะที่
ตอ้งการ   สามารถท าได ้2 วธีิ   

วิธีที่  1    1.  วางตวับอกต าแหน่งการพมิพใ์นยอ่หนา้ที่ตอ้งการ 
                 2.  คลิกที่ไอคอนบนพาเนล  Properties   
 

 
 
 
 

วิธีที่  2       1.  วางตวับอกต าแหน่งการพมิพใ์นยอ่หนา้ที่ตอ้งการ 
                 2.  เลือกเมนูค  าสัง่  Format  เลือกค าสัง่  Indent  หรือ  Outdent  
                        Indent   คือ  ขยบัยอ่หนา้เขา้ดา้นใน 
                        Outdent  คือ  ขยบัยอ่หนา้ออกดา้นนอก  

 

 
 
 
 

 

เยือ้งออก เยือ้งเข้ำ 
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  การขึน้บรรทดัใหม่ภายในย่อหน้า 
 ในโปรแกรม Dreamweaverr  การพิมพข์อ้ความในแต่ละบรรทดัโปรแกรมจะท าการตดัค  าขึ้น
บรรทัดใหม่ให้เองตามความกวา้งของหน้า  แต่ถ้าตอ้งการให้ขึ้ นบรรทดัใหม่ในต าแหน่งที่เราตอ้งการ  
สามารถท าไดด้งัน้ี 

1.   วางเคอร์เซอร์ยงัต  าแหน่งที่จะตดัขึ้นบรรทดัใหม่  หรือหลงัตวัอกัษรสุดทา้ยของบรรทดั 
2.   กดปุ่ ม  Shift + Enter   จะเห็นวา่ขอ้ความที่ตอ้งการใหข้ึ้นบรรทดัใหม่จะอยูบ่รรทดัใหม่ต่อจาก

บรรทดัแรก  แต่ยงัอยูภ่ายในยอ่หนา้เดียวกนั 
 

  การใส่สัญลกัษณ์แสดงหัวข้อย่อย   

 ในการพิมพข์้อความบนแฟ้มข้อมูล บางคร้ังเราอาจจะตอ้งการท าข้อความให้เป็นรายการที่มี
ลกัษณะเป็นหัวขอ้ยอ่ย   ซ่ึงในโปรแกรม Dreamweaverr   ก็สามารถใส่สัญลกัษณ์เหล่าน้ีไดเ้ช่นเดียวกับ
โปรแกรมอ่ืน  ซ่ึงสญัลกัษณ์เหล่าน้ีมีหลายรูปแบบ ไดแ้ก่   ตวัเลขล าดบั (Ordered) ,   สัญลกัษณ์  (Bullet)  ,  
รายการที่ไม่ตอ้งเรียงล าดบั  (Unordered)  และ รายการที่ไม่ใส่อะไรเลย  (Defintion List)   สามารถท าได ้2 
วธีิ 
 
วิธีที่  1   

1.   เลือกยอ่หนา้ทั้งหมดที่ตอ้งการใส่สญัลกัษณ์แสดงหวัขอ้ยอ่ยหรือเลขล าดบั 

2.   คลิกไอคอน    หรือ    บนพาเนล  Properties 
 
วิธีที่  2     

1.   เลือกยอ่หนา้ทั้งหมดที่ตอ้งการใส่สญัลกัษณ์แสดงหวัขอ้ยอ่ยหรือเลขล าดบั 
2.   เลือกเมนูค  าสัง่  Format  เลือกค าสัง่  List   แลว้เลือกหวัขอ้ตามตอ้งการ 
 

 
 
 
 
 
 
 

51



 

ตัวอย่างของสัญลักษณ์แสดงหัวข้อย่อยแต่ละชนิด 
Unordered  list      Ordered  list   Definition  list 

  หอ้งเรียนคอมพวิเตอร์  1.  หอ้งเรียนคอมพวิเตอร์   หอ้งเรียนคอมพวิเตอร์ 
 หอ้ง  Sound  Lab 2.  หอ้ง  Sound  Lab   หอ้ง Sound  Lab      
 หอ้ง  Play  Land 3.  หอ้ง  Play  Land     หอ้ง  Play  Land   
 

  การพมิพ์รายการหัวข้อย่อยขึน้ใหม่ 

1.   วางตวับอกต าแหน่งการพมิพใ์นต าแหน่งที่จะเร่ิมพมิพห์วัขอ้ยอ่ย 
2.   ใชไ้อคอนแสดงสัญลกัษณ์หัวขอ้ยอ่ยบนพาเนล  หรือ ใชค้  าสั่ง  Text  เลือก  List  จะปรากฏ
สญัลกัษณ์หนา้หวัขอ้ และพร้อมใหเ้ราพมิพร์ายการได ้  
3.   พมิพร์ายการหวัขอ้ยอ่ย  กด  Enter  เพือ่พมิพห์วัขอ้ถดัไป 

  4.   เม่ือพมิพร์ายการครบแลว้  ใหก้ด    Enter  สองคร้ัง 

 การพมิพ์รายการย่อยในหัวข้อย่อย 
1.   เลือกหวัขอ้ที่จะท าเป็นหวัขอ้ยอ่ย   

2.   คลิกไอคอน  Indent  ในพาเนล Properties  หรือใชค้  าสัง่  Text  เลือก   Indent   หวัขอ้
นั้นจะถูกเล่ือนไปเป็นหวัขอ้ยอ่ย   

3.     ถา้ตอ้งการพมิพห์วัขอ้ยอ่ยอ่ืนใหก้ดปุ่ ม   Enter   
 
 การแทรกช่องว่างเพือ่เว้นวรรค   

ในภาษา  HTML  จะอนุญาตใหเ้วน้วรรคตวัอกัษรไดเ้พียง 1 ช่องว่างเท่านั้น  ถา้เราตอ้งการให้เวน้
วรรคมากกวา่ 1 ช่องวา่งเราจะตอ้งท าการแทรกช่องวา่งลงไป  ซ่ึงสามารถท าได ้ 2 วธีิ  ดงัน้ี   
 
วิธีที่  1    

1.   น าเคอร์เซอร์ไปวางยงัต  าแหน่งที่ตอ้งการจะแทรกช่องวา่ง   
2.   ในแถบ Insert เลือกคลิปแทบ็  Text  แลว้คลิกที่ปุ่ ม            (Non-breaking  Space) 
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วิธีที่  2  
1.   น าเคอร์เซอร์ไปวางยงัต  าแหน่งที่ตอ้งการจะแทรกช่องวา่ง   
2.   กดปุ่ ม  Ctrl+Shift+Spacebar 
 

 การใช้อกัขระพเิศษ 

นอกเหนือจากการพมิพข์อ้ความหรือตวัอกัษรทัว่ ๆ ไป แลว้  เรายงัสามารถใชอ้กัขระพเิศษใหก้บั
เน้ือหาในเวบ็เพจของเราไดอี้กดว้ย  โดยมีวธีิการใชอ้กัขระพเิศษ  2 วิธี  ดงัน้ี   
วิธีที่  1    
               1.  น าเคอร์เซอร์ไปวางยงัต  าแหน่งที่ตอ้งการจะใชอ้กัขระพเิศษ  
               2.  ในแถบ  Insert   เลือกคลิปแทบ็  Text แลว้คลิกที่                  เพือ่เลือก 
อกัขระพเิศษที่ตอ้งการ 
 

 
 

 
 การใส่วนัที ่  

  ในการสร้างโฮมเพจนอกเหนือจากการใส่ขอ้ความแลว้เรายงัสามารถใส่วนัที่ เพือ่ใหแ้สดงวนัที่ปัจจุบนั
ในหนา้เวบ็เพจ  มีวิธีใส่วนัที่  2  วธีิ ดงัน้ี   
วิธีที่  1   
               1.  น าเคอร์เซอร์ไปวางยงัต  าแหน่งที่ตอ้งการจะใส่วนัที่ 
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               2.  ในแถบ  Insert   เลือกคลิปแทบ็  Common  แลว้คลิกที่ปุ่ ม              Date   
 

 
 
 
วิธีที่  2    
               1.  น าเคอร์เซอร์ไปวางยงัต  าแหน่งที่ตอ้งการจะใส่วนัที่ 
               2.  เลือกเมนูค  าสัง่  Insert   เลือกค าสัง่  Date   จะปรากฏไดอะล๊อกบล็อกซ์ของการใส่ 
                    วนัที่   ใหเ้ราก าหนดรายละเอียดของการใส่วนัที่ตามตอ้งการ  
 3.  เม่ือก าหนดไดแ้ลว้คลิกเมาส์ที่ปุ่ ม OK.  จะปรากฏวนัที่บนหนา้เวบ็เพจ  
 
 

 
   

 
    

 
 
 
 
 
 
 
 
 

 
 

 
 
 
 

น ำเคอร์เซอร์ไป
วำงยงัต ำแหน่งท่ี
ต้องกำรจะใสว่นัท่ี 

54



 

 
 
 
 
 
 
 
 
 
 
 
 

 

 
 
 

 การใส่เส้นคัน่แนวนอน   

การใส่เส้นคั่นแนวนอนในหน้าเว็บเพจเพื่อคัน่ขอ้มูลออกเป็นตอน ๆ  เพื่อสะดวกในการอ่าน
ขอ้ความที่มีการแบ่งส่วนไวอ้ยา่งชดัเจน   ท  าใหเ้วบ็เพจของเราอ่านง่ายและสวยงาม  โดยมีวิธีการใส่เส้นคัน่
แนวนอน  ดงัน้ี   
               1.  น าเคอร์เซอร์ไปวางยงัต  าแหน่งที่ตอ้งการจะใส่เสน้คัน่ 
               2.  เลือกเมนูค  าสัง่  Insert   เลือกเมนูค  าสัง่  HTML  >>>  Horizontal Rule  จะปรากฏเสน้คัน่ที่
เป็นสีเทาคัน่ขอ้ความ  
 
 

เลือกค ำสัง่ 
Insert > Date 

เลือกรูปแบบวนั 

เลือกรูปแบบวนัท่ี 

เลือกรูปแบบเวลำ 

คลกิ  

55



 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

เลือกค ำสัง่ 
Insert > HTML > 
Horizontal Rule   

จะปรำกฏเส้นคัน่
ท่ีเป็นสีเทำคัน่
ข้อควำม 
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  การปรับเปลี่ยนเส้นคัน่แนวนอน 

1.   เลือกเสน้คัน่แนวนอนที่จะปรับเปล่ียน          โดยการคลิกเมาส์ที่เสน้คัน่ซ่ึงเส้นคัน่จะมีแถบสีด า
คลุม  

2.   จะปรากฏพาเนล Properties  ของเสน้คัน่ที่ดา้นล่างของโปรแกรม  ให้เราท าการปรับเปล่ียนค่า
ต่าง ๆ  ในพาเนลไดต้ามตอ้งการ  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
 
 

คลกิเลือก
เส้นคัน่ 

จะปรำกฏ
พำเนล Properties  
ของเส้นคัน่ 

ก ำหนดควำมสงูของเส้น วำดเส้นแบบมีควำมลกึ 

ก ำหนดควำมยำวของเส้น จดัวำงต ำแหน่ง 

ตัง้ช่ือให้กบัเส้น 
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 การใส่รูปภาพลงในเวบ็เพจ 

 นอกเหนือจากการใส่ขอ้ความที่เป็นตวัอกัษรลงในเวบ็เพจแลว้  เรายงัสามารถใส่รูปภาพต่าง ๆ ลง
ไปในเวบ็เพจไดอี้กดว้ย   ซ่ึงรูปภาพก็เป็นส่วนที่ช่วยสร้างสีสนัใหก้บัเวบ็เพจของเราไดเ้ป็นอยา่งดี    โดยใน
เวบ็เพจน้ีอาจจะประกอบดว้ยรูปภาพ  เช่น  ภาพถ่าย ,  ภาพวาด ,  หรือรูปปุ่ มต่าง ๆ  ก็ได ้    และในการใส่
รูปภาพลงในเวบ็เพจยงัมีรายละเอียดเก่ียวกบัรูปภาพอีกมากมายดงัน้ี   

ชนิดของรูปภาพ    ชนิดของไฟลภ์าพมีอยูม่ากมายแต่ในที่น้ีจะแนะน า 4 ชนิด คือ           

1. GIF  (Graphic  Interchange  Format)  
เป็นรูปแบบของไฟลรู์ปภาพที่เป็นที่นิยมกนัอยา่งมาก ซ่ึงนิยมใชบ้นงานอินเตอร์เน็ตเน่ืองจากไฟลท์ี่

ไดจ้ะมีขนาดเล็ก  สามารถก าหนดสีไดสู้งสุด  256  สี  ท  าภาพโปร่งแสงและสร้างเป็นภาพเคล่ือนไหว  มกัใช้
กบัภาพการ์ตูน , โลโก ้และภาพเคล่ือนไหว  

2. JPEG  (Joint  Photographic  Experts  Group) 
         เป็นรูปแบบของไฟลรู์ปภาพที่สามารถก าหนดสีไดเ้ป็นลา้นสี และไฟลท์ี่ไดจ้ะมีขนาดเล็กกว่าไฟล ์

.GIF  แต่จะเก็บรายละเอียดของภาพไดน้้อยกว่า และสามารถที่จะบีบอดัไฟล์ได ้  เหมาะส าหรับภาพถ่าย  
รูปภาพจากสแกน , รูปภาพที่มีพื้นผวิ , และรูปภาพใด ๆ ที่มีสีมากกวา่  256  สี   

       3.    TIFF  (Tagged  Image File Format)   
               ไฟลป์ระเภทน้ีสามารถเก็บรายละเอียดของภาพไดเ้ป็นอยา่งดี  ท  าใหไ้ฟลท์ี่ไดมี้ขนาดคอ่นขา้งใหญ่    
จึงไม่นิยมน ามาใชง้านบนอินเตอร์เน็ต   

  4.       PNG  (Portable  Network Graphic)   
             เป็นรูปแบบของไฟลก์ราฟฟิคที่ใชบ้นเวบ็  แต่อาจใชไ้ม่ไดก้บัทุกบราวเซอร์  รองรับความลึกของ
สีแบบ  32  บิต  สามารถใส่เอ็ฟเฟ็คได้   ไฟล์ชนิดน้ีเป็นไฟล์มาตรฐานของโปรแกรม  Macromedia  
Fireworks   
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 วธีิการใส่รูปภาพลงในเวบ็เพจ  
 

 
  
 
 
 
 
 

 
 
 
 
 
 
 
 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

เลือกต ำแหน่งของ
ภำพท่ีต้องกำรจะวำง
บนหน้ำเวบ็แล้วเลือก

เคร่ืองมือ  
(image) แท็บ 
Common 

เลือกภำพท่ีต้องกำร 

คลกิ  เพ่ือตกลงเลือกภำพ  

จะได้รูปแสดงบนหน้ำเว็บ 

เขียนค ำอธิบำยรูปภำพ 
และคลกิ  
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 การปรับขนาดของรูปภาพ 

เม่ือเราท าการแทรกรูปภาพในเวบ็เพจแลว้  บางคร้ังรูปภาพที่แทรกอาจจะมีขนาดที่ใหญ่หรือเล็ก
เกินไป  จ  าเป็นตอ้งมีการปรับขนาดเพือ่ใหส้วยงามและเหมาะสมกบัเวบ็เพจ  โดยมีวธีิการดงัน้ี 

1.   คลิกที่รูปภาพที่จะปรับขนาด  จะปรากฏ  จุดยึด  (Handle)  ที่ขอบล่าง , ขอบขวา     และมุมขวา
ล่างของรูป   

 
 
 
 
 
 
 
 
 

 

2.   ลากจุดยดึเพือ่ปรับขนาด   หากตอ้งการใหมี้ขนาดเล็กลงให้ลากเมาส์เขา้ไปดา้นในภาพ  และถา้
ตอ้งการใหภ้าพมีขนาดใหญ่ให้ลากเมาส์ออกไปจากภาพ  และถา้หากตอ้งการให้ขนาดมีการขยาย หรือ ยอ่ 
ใหไ้ดส้ดัส่วนเท่ากนัระหว่างความกวา้งและความยาวให้กดปุ่ ม  Shift บนแป้นพิมพค์า้งไวข้ณะที่ลากเมาส์
ดว้ย 

 

 

 

 

 

 
 
 

จดุยึด  (Handle)   
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 ในการใชพ้าเนล  Properties  ของรูปภาพ  ถ้าเราคลิกเมาส์ที่รูปภาพจะปรากฏพาเนลด้านล่าง
โปรแกรม   ซ่ึงจะปรากฏภาพเล็กที่แสดงว่าเราเลือกภาพใดอยูบ่นพาเนลดว้ย  และในการปรับภาพนั้นจะมี
ขนาดของภาพบอกอยูใ่นพาเนลดว้ย  คือ W  หมายถึง  กวา้ง  , H  หมายถึง สูง   นอกจากการใชเ้มาส์ในการ
ปรับขนาดของภาพแลว้  เรายงัสามารถใส่ค่าตวัเลขของขนาดลงในช่อง  W , H   ไดอี้กดว้ย    และถ้า
ตอ้งการกลบัไปยงัขนาดปกติให้ลบค่าในส่วนของ  W  และ H  ออก แลว้กดปุ่ ม  Enter  หรือคลิกปุ่ ม  

   ในพาเนล  Properties 

 นอกจากน้ีดา้นล่างขวาของพาเนลจะมีสัญลกัษณ์    ซ่ึงแสดงว่ายงัมีรายละเอียดของการตั้งค่า
รูปภาพอยูอี่ก  ซ่ึงถา้คลิกเมาส์ที่สัญลกัษณ์น้ีจะปรากฏไอคอนการตั้งค่าเพิ่มขึ้นอีกสองแถวดา้นล่าง     และ
สญัลกัษณ์จะเปล่ียนเป็นรูป      ซ่ึงถา้คลิกที่สญัลกัษณ์น้ีอีกคร้ังก็จะเป็นการซ่อนไอคอนให้เหลือแค่สอง
แถวบนตามเดิม 
 
 
 
 

 
 
 
 
 
 
 
 
  
 

 
 
 
 
 
 

ปรับควำมกว้ำงของรูปภำพ 

ใสช่ื่อของรูปภำพ แสดงท่ีเก็บไฟล์รูป 

ใสข้่อควำมก ำกบัรูป 

จดัต ำแหน่งกำรวำงภำพ 

ปรับควำมสงูของรูปภำพ 

ใช้ก ำหนดกำรเช่ือมโยงภำพไปยงัข้อมลูหรือเว็บไซต์อ่ืน 

ก ำหนดควำมหนำของเส้นขอบภำพ 

ก ำหนดต ำแหน่งของภำพในหน้ำเวบ็ 
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 การจดัวางต าแหน่งรูปภาพ 

เม่ือเราท าการแทรกรูปภาพและก าหนดขนาดที่พอใจแลว้  และถา้ตอ้งการจดัวางในต าแหน่งต่าง ๆ  
บนเวบ็เพจ     รวมทั้งการจดัวางร่วมกบัขอ้ความดงัต่อไปน้ี   

-  Default                  วางบนขอบล่าง   หรือเป็นไปตามค่าปกติของโปรแกรม 
                                                       เวบ็บราวเซอร์ที่ผูช้มใช ้

-  Baseline  วางขอบล่างของภาพเสมอแนวขอบล่างของขอ้ความ 
-  Top    วางขอบบนของภาพเสมอกบัขอบบนที่สูงสุดของขอ้ความหรือ 

ออบเจค็อ่ืนที่อยูใ่นบรรทดันั้น 
-  Middle  วางก่ึงกลางของภาพเสมอกบัขอบล่างของขอ้ความบรรทดันั้น 
-  TextTop  วางขอบบนของภาพเสมอกบัขอบบนของขอ้ความในบรรทดันั้น  

                                                       วางขอบบนของภาพ 
- Absolute  Middle วางก่ึงกลางของภาพเสมอกบัก่ึงกลางของขอ้ความบรรทดันั้น 
- Absolute  Bottom วางขอบล่างของภาพเสมอแนวขอบล่างของขอ้ความ รวมถึง  ตวัอกัษรที่มี

หางหอ้ย เช่น g ดว้ย 
- Left    วางภาพไวท้างขอบซา้ย  และจดัขอ้ความไวท้างขวาของภาพ 
- Right    วางภาพไวท้างขอบขวา  และจดัขอ้ความไวท้างซา้ยของภาพ 

           
 

ตัวอย่างการจัดวางต าแหน่งของรูปภาพร่วมกับข้อความ 
 

       
 
 
 

Default 

 
 
 
 
 

 
  

Default Baseline  
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  Middle 

 
 
 
 
 
 
 

 

 
 
 
 
 
 
 
 

 
  

 
 
 
 
 
 
 

 

 

 

Top 

TextTop 

Left Absolute  Bottom 

Middl
e 

Absolute 

Right 
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 การใส่รูปภาพเป็นพืน้ฉากหลงั   

 โดยปกติพื้นหลงัเวบ็เพจจะมีสีขาว  แต่หากเราตอ้งการน าภาพสวย ๆ  มาเป็นพื้นหลงัเวบ็เพจ   หรือ
ตอ้งการเปล่ียนสีขาวของพื้นหลงัใหมี้รูปโลโกต่้าง ๆ  ดงัน้ี   

 

 

 

 

 

 

 

 

 

 

 

 

เลือกค ำสัง่ Modify > Page Properties… 

คลกิปุ่ ม  

เพ่ือก าหนดรูปท่ีจะ
น ามาใช ้
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เลือกไฟล์ภำพพืน้หลงั
ท่ีจะน ำมำใช้  

คลกิปุ่ ม   

คลกิปุ่ ม   

คลกิปุ่ ม  
เพ่ือดผูลลพัธ์ก่อนแสดงผล
ท่ีหน้ำจอ 
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การสร้างตาราง (Table) 

มาตรฐานการเรียนรู้/ ตัวช้ีวดั 

กลุ่มสาระการงานอาชีพและเทคโนโลย ี

สาระที ่๒ การออกแบบและเทคโนโลยี 

     มาตรฐาน ง ๒.๑  เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ี ออกแบบและสร้างส่ิงของเคร่ืองใช ้

หรือวธีิการ ตามกระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรค ์ เลือกใชเ้ทคโนโลยใีนทางสร้างสรรค์

ต่อชีวติ  สงัคม   ส่ิงแวดลอ้ม  และมีส่วนร่วมในการจดัการเทคโนโลยทีี่ย ัง่ยนื 

ตัวช้ีวดั 
        ๑.ง ๒.๑/๓ สร้างและพฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลยอียา่งปลอดภยัโดย

ถ่ายทอดความคิดเป็นภาพฉายและแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  หรือถ่ายทอดความคิดของ

วธีิการเป็นแบบจ าลองความคิดและการรายงานผลโดยใชซ้อฟแวร์ช่วยในการออกแบบหรือน าเสนอผลงาน 

สาระส าคญั 
       สร้างและพฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลยอียา่งปลอดภยัโดยถ่ายทอด

ความคิดเป็นภาพฉายและแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  หรือถ่ายทอดความคิดของวธีิการเป็น

แบบจ าลองความคิดและการรายงานผลโดยใชซ้อฟแวร์ช่วยในการออกแบบหรือน าเสนอผลงาน 

สาระการเรียนรู้ 

- ความรู้ 
  ๑.เขา้ใจและพฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลย ี

  ๒.ถ่ายทอดความคิดของวธีิการเป็นแบบจ าลองความคิดและการรายงานผล 

  ๓.เขา้ใจการน าเสนอผลงาน 
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 - ทกัษะ / กระบวนการ 

    ๑.สามารถถ่ายทอดความคิดของวธีิการเป็นแบบจ าลองความคิดและการรายงานผล 

    ๒.ทกัษะการน าเสนอผลงานกลุ่มหรือเด่ียว 

- คุณลกัษณะทีพ่งึประสงค์ 

   ๑.มีวนิยั 

   ๒.ใฝ่เรียนรู้ 

   ๓.มุ่งมัน่ในการทางานรู้เรียนรู้ 
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การใชต้าราง เหมาะส าหรับการน าเสนอขอ้มูลจ านวนมากที่ตอ้งการจดัใหเ้ป็นระเบียบ โดยอยูใ่นรูป
ของแถวและคอลมัน์ เช่น จดัเก็บคะแนน, ขอ้มูลหุน้, และการแสดงยอดขายสินคา้ชนิดต่างๆ ในเวบ็เพจให้
อยูใ่นต าแหน่งที่ตอ้งการไดอ้ยา่งเป็นสดัส่วนอีกดว้ย  

 นอกจากน้ี เรายงัสามารถแทรกภาพรวมกบัขอ้ความในช่องตารางแต่ละช่อง เพือ่แบ่งแยกขอ้ความที่
ใชป้ระกอบภาพในแต่ละภาพไดอ้ยา่งชดัเจน และเป็นระเบียบ 

    การสร้างตาราง 

 การสร้างตารางในโปรแกรม Dreamweaver สามารถท าไดง่้ายๆ เพราะมีเคร่ืองมือ  (Table) ที่
ช่วยสร้างตารางบนเวบ็เพจของเราไดต้ามตอ้งการ วธีิการสร้างตารางนั้น มีขั้นตอนในการสร้างตารางอยู ่3 
วธีิ คือ 

 วิธีที่ 1 เลือกเมนูค  าสัง่ Insert > Table 

 

 

 

 

 

 

 

 

 

 

การสร้างตาราง  (Table) 
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 วิธีที่ 2  เลือกเคร่ืองมือ  (Table) ที่แทบ็ Common หรือแทบ็ Layout 

 

 วิธีที่ 3 กดคีย ์<Ctrl+Alt+T> ที่แป้นพมิพ ์

 

 โดยทั้ง 3 วิธีน้ีจะแสดงหนา้ต่าง Table ส าหรับใชก้ าหนดรายละเอียดเก่ียวกบัตาราง ดงัน้ี 

Rows  จ านวนแถวที่ตอ้งการ 

Columns  จ านวนคอลมัน์ที่ตอ้งการ 

Table Width  ความกวา้งของตารางหน่วยที่ใชจ้ะเป็นเปอร์เซ็นต ์หรือพกิเซลก็ได ้

Border Thickness ความหนาของขอบตาราง 

Cell padding  ระยะห่างระหวา่งขอ้ความภายในเซลลก์บัขอบเซลล ์

Cell spacing  ระยะห่างระหวา่งแต่ละเซลลใ์นตาราง 

Header ก าหนดใหเ้ราสามารถพมิพห์วัขอ้ของขอ้ความภายในเซลล ์และจดัวาง
ตรงส่วนไหนของตาราง โดยก าหนดไดด้งัน้ี 
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Caption ก าหนดหวัขอ้ของตาราง 

Align caption จดัวางหวัขอ้ของตารางไวใ้นต าแหน่งที่ตอ้งการ โดยที่ 
default ไม่มีการก าหนดค่า ใหใ้ชค้่าปกติ นัน่คือจดัวางหวัขอ้ของตารางไวข้า้งบนและจดั     

วางตารางกลางของตาราง 
 top  จดัวางหวัขอ้ของตารางไวข้า้งบน และจดัต าแหน่งตรงกลางของตาราง 
 bottom  จดัวางหวัขอ้ของตารางไวด้า้นล่าง และจดัต าแหน่งตรงกลางของตาราง 
 left  จดัวางหวัขอ้ของตารางไวด้า้นบน แต่จดัต าแหน่งไวชิ้ดซา้ยของตาราง 
 right   จดัวางหวัขอ้ของตารางไวด้า้นบน แต่จดัต าแหน่งไวชิ้ดขวาของตาราง 

Summary เขียนค าอธิบายเก่ียวกบัตาราง แต่ไม่แสดงใหเ้ห็นบนหนา้เวบ็ จะถูกฝังไวใ้นโคด้ 
HTML เท่านั้น  

 เม่ือก าหนดค่าตามที่เราตอ้งการในหนา้ต่าง Table แลว้ ใหเ้ราคลิกเมาส์ปุ่ ม  เราก็จะได้
ตารางตามที่ก  าหนดไว ้ซ่ึงใน Dreamweaver เม่ือเราสร้างตารางจะมีส่วนที่เรียกวา่ ส่วนที่ใชจ้ดัการตาราง/
คอลมัน์เพิม่ขึ้นมา ซ่ึงมีประโยชน์ในการจดัระเบียบตาราง และขอ้มูลใหง่้าย และดูสวยงาม 

 

ไมมี่การก าหนดหวัข้อ
ของข้อมลูในตาราง 

ก าหนดให้คอลมัน์แรก
เป็นหวัข้อของเซลล์ 

ก าหนดให้แถวแรกเป็น
หวัข้อของเซลล์ 

ก าหนดให้ทัง้แถวและคอลมัน์
แรกเป็นหวัข้อของเซลล์ 
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 ใส่ข้อมูลในตาราง 

 เราสามารถใส่ขอ้มูลเขา้ไปในตารางที่สร้างได ้โดยคลิกเลือกช่องเซลลท์ี่ตอ้งการ แลว้พมิพข์อ้ความ
ที่ตอ้งการลงไปไดเ้ลย 

 

 

ใส่รูปภาพในตาราง 

 เม่ือเราตอ้งการแทรกภาพลงในช่องตาราง และปรับขนาดภาพใหพ้อดีกบัช่องตาราง ก็สามารถท าได ้
ดงัน้ี 

 

 

 

 

คลกิเมาส์ท่ีช่องใดช่องหนึ่ง
ของตารางเพ่ือใส่ข้อความ 

พมิพ์ข้อความท่ีต้องการลง
ไปในช่องตาราง และปรับแตง่
ข้อความตามต้องการ 

คลกิเมาส์ท่ีช่อง
ใดช่องหนึ่งของ
ตารางเพ่ือใส่
ข้อความ 

เลือกเคร่ืองมือ  (Images) ท่ีแท็บ Common 

71



 

 

 

 

 

 

 

เลือกไฟล์ภาพท่ี
จะน ามาประกอบ 

คลกิปุ่ ม  เพ่ือตกลง 

เขียนค าอธิบาย
รูปภาพ 
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 ปรับขนาดช่องตาราง 

 เราสามารถปรับขนาดของช่องตารางในแถว หรือคอลมัน์ของตารางใหไ้ดส้ดัส่วนตามที่เราตอ้งการ 
โดยการคลิกที่เสน้ตาราง และลากเมาส์ปรับขนาดได ้
 

 

 

แสดงภาพท่ีน ามาประกอบ 

เม่ือเราคลกิท่ีเส้นนอนภายในตารางตวัช้ีเมาส์จะเปล่ียนเป็นรูป  
เพือ่ปรับตารางในแนวนอน โดยการลากเมาส์ปรับขนาด 
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 การเลอืกตาราง แถว คอลมัน์ และเซลล์ 

 การท างานกบัตารางไม่วา่จะเป็นการตกแต่งรายละเอียด หรือจดัรูปแบบตาราง ลว้นตอ้งเลือกตาราง
ช่องต่างๆก่อนเสมอ  

เลือกทั้งตาราง 

 การเลือกทั้งตาราง มีอยู ่3 วธีิ คือ 

 วิธีที่ 1 ใหเ้ล่ือนเมาส์ไปที่ขอบตารางจนตวัช้ีเมาส์เปล่ียนเป็น  แลว้คลิกเมาส์เพือ่เลือกทั้งตาราง 

 

 

 

 

 

 

เม่ือเราคลกิท่ีเส้นตัง้ภายในตารางตวัชีเ้มาส์จะเปล่ียนเป็นรูป  
เพ่ือปรับตารางในแนวตัง้ โดยการลากเมาส์ปรับขนาด 

คลกิเมาส์ท่ีขอบตาราง เพ่ือเลือกทัง้ตาราง 

74



 

 

 วิธีที่ 2 ใหเ้ลือกเซลลใ์ดก็ไดใ้นตารางและเลือกค าสัง่ Modify > Table > Select Table 

  

 วิธีที่ 3 ขณะเลือกเซลลใ์ดๆ อยู ่ใหค้ลิกที่แทก็ <Table> ที่แถบสถานะดา้นล่างของหนา้เวบ็ที่เรา
ก าลงัท างานอยู ่

 

 

เลือกเมนคู าสัง่  
Modify > Table 
> Select Table 

คลกิท่ีแท็ก <table> เพ่ือเลือกทัง้ตาราง 
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 การเลือกเซลล์ 

 การเลือกเซลล์เดยีว 
การเลือกเซลลเ์ดียวที่ตอ้งการท างานดว้ย มีวธีิง่ายๆ โดยการคลิกเมาส์ช่องเซลลท์ี่จะเลือกหรือคลิกที่

แทก็ <td> ที่แถบสถานะก็ได ้
 

 

 

 

  

 

 

 

 

 

 

คลกิท่ีช่องเซลล์ท่ีต้องการจะเลือก 

แล้วคลกิท่ีแท็ก <td> เพ่ือก าหนดการ

เลือกเซลล์ที่เราตอ้งการ 
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 การเลือกหลายเซลล์ทีอ่ยู่ติดกันในตาราง 

 ใหเ้ราเลือกเซลลแ์รกที่ตอ้งการ จากนั้นกดคีย ์<shift> คา้งไว ้แลว้คลิกเลือกเซลลสุ์ดทา้ยก็จะเป็น
การเลือกทุกเซลลท์ีอ่ยูร่ะหวา่งเซลลท์ั้งสอง ดงัรูป 

 

 

 

 

 

 

คลกิเลือกเซลล์
แรกท่ีต้องการ 

กดคีย์ <Shift>
ค้างไว้ แล้วคลกิ
เลือกเซลล์สดุท้าย 
ก็จะเป็นการเลือก
ทกุเซลล์ท่ีอยู่
ระหวา่งเซลล์ทัง้สอง 
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 การเลือกหลายเซลล์ที่ไม่อยู่ติดกันในตาราง 

 ใหค้ลิกเมาส์เลือกเซลลแ์รก และใหก้ดคีย ์<Ctrl> คา้งไวก่้อนเลือกเซลลต่์อไปที่ไม่อยูติ่ดกนั ดงัน้ี 

 

 

 

 

 

 

คลกิเซลล์ 
ท่ีเลือก 

กดคีย์ <Ctrl>
ค้างไว้ แล้วคลกิ
เลือกเซลล์ท่ี
ต้องการเลือก 
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 การเลือกแถว 

 1.น าเมาส์ไปวางหนา้แถวที่ตอ้งการเลือก จะปรากฏลูกศรสีด าหนา้แถวนั้น 

 2.ใหค้ลิกที่ลูกศร ก็จะเป็นการเลือกแถวนั้นทั้งแถว หรือจะคลิกเลือกเซลลใ์ดก็ไดใ้นตาราง และคลิก
แทก็ <tr> ที่เป็นของแถวนั้น 

 

 

 

 

 

 

 

 

 

 

 

เม่ือเมาส์กลายเป็น
ลกูศรสีด า ให้คลกิ
เมาส์ในแถวท่ีต้องการ
เลือกทัง้หมด 

เม่ือเมาส์กลายเป็นลกูศรสีด า ให้คลกิเมาส์ใน
แถวท่ีต้องการเลือกทัง้หมด 
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 การเลือกคอลัมน์ 

 1.น าเมาส์ไปวางไวบ้นคอลมัน์ที่ตอ้งการเลือก จะปรากฏลูกศรสีด าอยูบ่นคอลมัน์นั้น 

 2.ใหค้ลิกที่ลูกศรจะเป็นการเลือกทั้งคอลมัน์นั้น 

 

 

 

 

 การจดัการกบัตารางทีเ่ลอืก 

 ในโปรแกรม Dreamweaver ไดเ้พิม่ส่วนที่ใชจ้ดัการกบัตารางที่เราเลือก โดยแบ่งออกเป็น 2 ส่วน 
คือ ส่วนที่ใชจ้ดัการกบัคอลมัน์ทั้งตาราง และส่วนที่ใชจ้ดัการคอลมัน์ที่เลือก ช่วยจดัระเบียบของขอ้มูลใน
ตารางใหไ้ดส้ดัส่วนมากขึ้น ดงัรายละเอียดต่อไปน้ี 

 

 

 

เม่ือเมาส์กลายเป็นลกูศรสีด า ให้คลกิเมาส์
ในคอลมัน์ท่ีต้องการเลือกทัง้หมด 
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 จัดการกับคอลัมน์ทั้งตาราง 

 มีประโยชน์คือ ใชจ้ดัระเบียบของตารางและขอ้มูลในตารางใหดู้สมส่วนและสวยงาม ดงัตวัอยา่งเรา
จะลบค่าช่องวา่งของคอลมัน์ทั้งตารางตามแนวกวา้ง เพือ่ให้ช่องตารางพอดีกบัภาพ และขอ้ความในช่อง
ตารางทั้งหมด โดยเลือกที่ค  าสัง่ Clear All Widths มีขั้นตอนดงัน้ี 

 

 

  

 

คลกิเมาส์ปุ่ มลกูศร แล้วเลือกค าสัง่ 
Clear All Widths เพ่ือลบช่องวา่งของ
คอลมัน์ทัง้ตารางตามแนวกว้าง 
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1. คลิกเมาส์ที่ปุ่ มลูกศร  ของช่องตารางทั้งตาราง แลว้เลือกค าสัง่ที่ใชใ้นการจดัการกบัคอลมัน์ทั้งตาราง 
ดงัน้ี 

* Select Table เลือกตารางทั้งหมด 

* Clear All Heights ลบค่าช่องวา่งตามความสูงของทั้งตาราง 

* Clear All Widths ลบค่าช่องวา่งตามความกวา้งของทั้งตาราง 

* Make All Widths Consistent ท าใหค้วามกวา้งในแต่ละคอลมัน์กวา้งเท่ากนัหมด 

* Hide Table Widths ซ่อนส่วนที่ใชจ้ดัการตารางน้ี (หากตอ้งการใหแ้สดงความกวา้ง
ของตารางอีกคร้ังใหเ้ลือกค าสัง่ View > Visual Aids > Table 
Widths) 

ในตวัอยา่งจะเลือกใชค้  าสัง่ Clear All Widths เพือ่ลบค่าช่องวา่งของคอลมัน์ทั้งตารางตามแนวความ
กวา้ง 

2.แสดงการลบค่าช่องวา่งของคอลมัน์ทั้งตาราง ท าใหแ้ต่ละคอลมัน์มีขนาดตามขอ้มูลที่อยูใ่นนั้น 

 

 

แสดงการลบช่องวา่งของคอลมัน์ทัง้ตาราง 
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 จัดการเฉพาะคอลัมน์ 

 เราสามารถจดัการเฉพาะคอลมัน์ที่เราเลือกได ้ดงัตวัอยา่งเราจะสัง่ลบช่องวา่งในคอลมัน์แรกให้
พอดีกบัขอ้ความ 

1.คลิกเมาส์ที่ปุ่ มลูกศร  ในคอลมัน์ที่เราจะลบความกวา้ง โดยมีค  าสัง่ใหเ้ราเลือก ดงัน้ี 

* Select Column เลือกเซลลท์ั้งหมดในคอลมัน์ที่เราเลือก 

* Clear Column Width ลบค่าช่องวา่งของคอลมัน์ที่เราเลือก 

*Insert Column Left เพิม่คอลมัน์ใหม่ดา้นซา้ยจากคอลมัน์ที่เราเลือก 

*Insert Column Right เพิม่คอลมัน์ใหม่ดา้นขวาจากคอลมัน์ที่เราเลือก 

 

2.แสดงการลบค่าช่องวา่งเฉพาะในคอลมัน์ที่เราเลือก 
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 การปรับแต่งรายละเอยีดของตาราง 

 นอกจากการใชเ้มาส์ปรับคุณสมบติัต่างๆของตารางแลว้ เรายงัสามารถก าหนดรายละเอียดต่างๆ ได้
จาก Properties Inspector โดยเม่ือเราคลิกเลือกตาราง หรือคอลมัน์ หรือเซลลใ์นตารางแลว้ ก็จะสามารถปรับ
ขนาดเซลล/์แถว/คอลมัน์ ปรับความสูง/ความกวา้ง/ความหนาของตาราง อีกทั้งสามารถเลือกต าแหน่งที่จะ
วางตารางบนเวบ็เพจได ้

 

 

 

   
 

 

 

 

 

 

 

 

 

 

 

ช่ือตาราง ระบคุวามกว้างของตาราง 

สีพืน้หลงั สีเส้นขอบตาราง 
รูปภาพพืน้หลงัท่ีเราสามารถ
ก าหนดให้กบัตารางได้ 

ก าหนดจ านวนแถวและคอลมัน์ 

ก าหนดต าแหน่งของตารางในหน้าเวบ็ 
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รูปแบบ ค าอธิบาย 

Tale ID ก าหนดช่ือตารางน้ี (เราจะอา้งอิงถึงช่ือตารางเม่ือมีการใช ้Behavior) 

Rows, ID (จ  านวนแถวและคอลมัน)์ระบุจ  านวนแถวและคอลมัน์ของตาราง
ตามตอ้งการใชร้ะบุความกวา้งของตาราง โดยระบุเป็นเปอร์เซ็นต์
เทียบกบัความกวา้งของหนา้ต่างบราวเซอร์ หรือ ระบุเป็นพกิเซลก็
ได ้หากเราไม่ระบุค่าในช่องน้ี บราวเซอร์ที่เปิดดูเวบ็อาจแสดงขนาด
ตารางไม่ตรงกบัที่ตอ้งการ 

CellPad ก าหนดระยะห่างระหวา่งขอ้ความในตารางกบัขอบตาราง ค่าน้ีมีผล
กบัทั้งตารางค่าที่ก  าหนดไวเ้ป็นมาตรฐานคอื 1 

CellSpace ก าหนดระยะห่างระหวา่งเซลลท์ี่อยูใ่นตาราง ค่าน้ีมีผลกบัทั้งตาราง
ค่าที่ก  าหนดไวเ้ป็นมาตรฐานคอื 2 

Align ใชร้ะบุการจดัวางตารางให้ชิดซา้ย (Left) ชิดขวา (Right) ก่ึงกลาง 
(Center) หนา้เวบ็ได ้โดยค่าที่ตอ้งการใหมี้เสน้ขอบตารางใหก้ าหนด
ไวเ้ป็นมาตรฐาน (Default) คือ Left 

Border ถา้เราไม่ตอ้งการใหมี้เสน้ขอบตารางใหก้ าหนดค่าในช่องน้ีเป็น 0 
หากตอ้งการใหมี้เสน้ขอบตาราง ใหก้ าหนดความหนาของเสน้ขอบ
ไดใ้นช่องน้ี 

Clear Row Heights, Clear 
Column Widths 

คลิกเมาส์เพือ่ลบคา่ความสูง หรือความกวา้งของแถวหรือคอลมัน ์

Convert Table Widths to 
Pixel, Percent  

คลิกเมาส์เพือ่แปลงค่าความกวา้งของตารางที่เราก าหนดไวจ้าก
พกิเซลเป็นค่าเปอร์เซ็นตห์รือจากค่าเปอร์เซ็นตเ์ป็นค่าพกิเซล 

Class ใชใ้นกรณีที่เราก าหนดค่า CSS ใหก้บัตาราง 

Bg Image, Bg Color, Brdr 
Color (Bord color) 

ระบุภาพที่จะใชเ้ป็นพื้นหลงัของตาราง หรือสีที่ใชเ้ป็นพื้นหลงั และ
สีของขอบตาราง 
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 การจดัข้อความในตาราง 

จัดข้อมูลในแนวนอน 

 เราสามารถจดัขอ้มูลที่แสดงในช่องตารางใหชิ้ดขวา ชิดซา้ย หรืออยูก่ึ่งกลางของช่องตาราง โดยการ
คลิกช่องตารางที่ตอ้งจดัขอ้มูล แลว้ก าหนดต าแหน่งของขอ้มูลในช่อง Horz จาก Properties Inspector ดงัน้ี 

 

 

  จดัเรียงขอ้มูลแบบปกติ (คอืจดัใหอ้ยูชิ่ดซา้ยของช่องตาราง) 

 จดัเรียงขอ้มูลใหอ้ยูชิ่ดซา้ยของตาราง 

 จดัเรียงขอ้มูลใหอ้ยูก่ึ่งกลางของช่องตาราง 

 จดัเรียงขอ้มูลใหอ้ยูชิ่ดขวาของตาราง 

 

 

คลกิช่องตารางท่ีต้องจดัข้อมลู 
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 จัดข้อมูลในแนวต้ัง 

 ถา้เรามีช่องตารางที่ขยายออกมากกวา่ 1 แถว เราสามารถก าหนดขอ้มูลในตารางช่องนั้นใหอ้ยูชิ่ดบน 
ชิดล่าง หรืออยูก่ึ่งกลาง โดยการคลิกช่องตารางที่ตอ้งการจดัขอ้มูล แลว้ก าหนดต าแหน่งของขอ้มูลในช่อง 
Vert จาก Properties Inspector ดงัน้ี 

 

 

 จดัเรียงขอ้มูลแบบปกติ (คอืจดัใหอ้ยูก่ึ่งกลางของช่องตาราง) 

 จดัเรียงขอ้มูลใหอ้ยูชิ่ดขวาของตาราง 

 จดัเรียงขอ้มูลใหอ้ยูชิ่ดขวาของตาราง 

 จดัเรียงขอ้มูลใหอ้ยูชิ่ดขวาของตาราง 

 จดัเรียงขอ้มูลใหอ้ยูชิ่ดขวาของตาราง 
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 การเปลีย่นแปลงจ านวนแถวและคอลมัน์ 

  การแทรกคอลมัน์ 
   เราสามารถแทรกคอลมัน์เพือ่เพิม่คอลมัน์ในตารางไดโ้ดยขั้นตอนต่อไปน้ี 
1. คลิกที่เซลลต์รงคอลมัน์ที่จะแทรก 
2. หากตอ้งการแทรกคอลมัน์ ใหเ้ลือกเมนูค  าสัง่  Modify >  Table >  Insert  Column 

 
 
 
 
 
 
 
 
 
 
 

 

 หากตอ้งการแทรกคอลมัน์ทางซา้ยหรือทางขวาของเซลลน์ั้น ใหเ้ลือกเมนูค  าสัง่  Modify > Table > 
Insert Rows or Columns แลว้เลือกตวัเลือกดงัรูป 

 

 

 

เลือก Column 

ก าหนดจ านวน 

Column ท่ีต้องการเพิม่ 

เลือกต าแหน่งท่ี
จะแทรกคอลมัน์ 
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  การแทรกแถว 
 นอกจากเราสามารถแทรกคอลมัน์ไดแ้ลว้เรายงัสามารถแทรกแถวไดเ้ช่นเดียวกนั 
โดยวิธีต่อไปน้ี 

1. คลิกที่เซลลต์รงแถวที่จะแทรก 
2. หากตอ้งการแทรกแถว ใหเ้ลือกเมนูค  าสัง่ Modify > Table > Insert Row   

 
 
 
 
 
 
 
 
 
 
 
 
 

 หากตอ้งการแทรกแถวดา้นบนหรือดา้นล่างของเซลลน์ั้น ใหเ้ลือกเมนูค  าสัง่  Modify > Table > 
Insert Rows or Columns แลว้เลือกตวัเลือกดงัรูป 

 

 

 

เลือก Rows 

ก าหนดจ านวน 

Column ท่ีต้องการเพิม่ 

เลือกต าแหน่งท่ี
จะแทรกแถว 
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  การลบแถวหรือคอลมัน์  เราสามารถลบแถวหรือคอลมันไ์ดโ้ดยวธีิต่อไปน้ี 

1. คลิกที่แถวหรือคอลมัน์ที่ตอ้งการจะลบ 
2. การลบแถว ใหเ้ลือกเมนูค  าสัง่ Modify >  Table >  Delete Row  

การลบคอลัมน์ ใหเ้ลือกเมนูค  าสัง่ Modify  > Table >  Delete Column 
 
 
 

 
 
 
 
 

  การรวมเซลล์ 
 เราสามารถรวมเซลลใ์นตารางไดโ้ดยวิธีต่อไปน้ี 

1. เลือกเซลลท์ี่จะรวม(ตอ้งเป็นเซลลท์ี่ติดกนั) โดยกด <Ctrl> คา้งไวพ้ร้อมกบัเลือกเซลลท์ี่จะ
รวมกนั 

2. เลือกเมนูค  าสัง่ Modify > Table  > Merge Cells หรือ คลิกที่ปุ่ ม  ( Merge Cells)  ในพาเนล 
Properties 
 
 

 

 การแบ่งเซลล์ 
    เราสามารถแบ่งเซลลไ์ดโ้ดยวธีิต่อไปน้ี 

1. คลิกที่เซลลท์ี่ตอ้งการแบ่ง 
2. เลือกเมนูค  าสัง่ Modify > Table  > Split Cell  หรือ คลิกที่ปุ่ ม   (Split Cell)  ในพาเนล 

Properties 
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3. จะปรากฏหนา้ต่าง Split Cell ขึ้นมาใหเ้ลือกรูปแบบของการแบ่งเซลล ์ดงัน้ี 
 

 

  

 การขยายและลดความกว้างเซลล์ในตาราง 

 นอกจากการรวมเซลล ์และการแยกเซลล ์เราสามารถปรับเปล่ียนบางช่องเซลลใ์นตารางใหข้ยาย
ออกมามากกวา่ 1 คอลมัน์ หรือ 1 แถวก็ได ้เพือ่ใชใ้นการจดัเรียงขอ้มูลอยา่งเหมาะสม 

การขยายช่องเซลล์ 

 ในที่น้ีจะแสดงตวัอยา่งการเพิม่ความกวา้งเซลลต์ามแนวตั้ง และตามแนวนอน ซ่ึงเราท าไดโ้ดยการ
คลิกเมาส์ปุ่ มขวา เลือกช่องเซลลท์ี่ตอ้งการปรับ เลือกค าสัง่ Modify > Table > Increase Row Span เพือ่เพิม่
ความกวา้งเซลลต์ามแนวตั้งลงมาดา้นล่าง หรือเลือก Modify > Table > Increase Column Span เพื่อเพิม่
ความกวา้งเซลลต์ามแนวนอนไปทางขวา ดงัรูป  
 

 

 

 

 

 

 

 

ก าหนดการแบง่เซลล์
ตามแนวแถวหรือคอลมัน์ 

ก าหนดจ านวนเซลล์ท่ีจะแบง่ 

เลือกช่องเซลล์ท่ีต้องการปรับ 
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แสดงผลค าส่ัง Increase Row Span  

แสดงผลค าส่ัง Increase Column Span  
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    การคนืสภาพช่องเซลล์ 

 จากหวัขอ้ที่ผา่นมาเราไดข้ยายขนาดของช่องเซลลใ์นแนวตั้ง และแนวนอนเรียบร้อย ในหวัขอ้น้ีเรา
สามารถสามารถปรับช่องเซลลท์ี่เราขยายคืนสู่สภาพเดิม โดยเลือกค าสัง่ Modify > Table > Decrease Row 
Span ส าหรับการคืนสภาพเซลลใ์นแถว หรือ Modify > Table > Decrease Column Span ส าหรับการคืน
สภาพเซลลใ์นคอลมัน์ ดงัน้ี 

 

 

 

 

 

 

 

 

 

 
 

 

 

เลือกค าสัง่ Modify > Table > 
Decrease Row Span ส าหรับการ
คืนสภาพเซลล์ในแถว หรือ Modify > 
Table > Decrease Column Span 
ส าหรับการคืนสภาพเซลล์ในคอลมัน์ 

แสดงผลค าส่ัง Decrease Row Span 
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การปรับความกว้างของตารางใน Properties Inspector 
 ใน Properties Inspector มีค  าสัง่ที่ใชก้  าหนดความกวา้งของทั้งตาราง หรือเซลลใ์ดๆ ในตาราง โดย
เราสามารถระบุค่าที่เจาะจงส าหรับการปรับขนาดของตารางไดเ้อง ดงัน้ี 

ปรับความกว้างของทั้งตาราง 

 เราสามารถปรับขนาดความกวา้งของทั้งตารางได ้โดยคลิกเลือกทั้งตาราง จากนั้นก าหนดขนาด
ความกวา้งในช่อง  (ก าหนดเป็นเปอร์เซ็นตเ์ทียบกบัความกวา้งของหนา้ต่างบราวเซอร์ หรือระบุ
เป็นพกิเซลดว้ยขนาดที่เฉพาะเจาะจงก็ได)้  

 

 

แสดงผลค าส่ัง Decrease Column Span 

คลกิเลือกทั้งตาราง 

ก าหนดความกว้างของตาราง 
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ปรับความสูงและความกว้างของช่องเซลล์ 

 เราสามารถก าหนดขนาดความกวา้งของช่องตารางไดอ้ยา่งเจาะจง โดยคลิกที่ช่องตารางที่ตอ้งการ

ปรับขนาด แลว้ก าหนดขนาดความกวา้งในช่อง  ก าหนดความสูงในช่อง  โดยมีขั้นตอน
ดงัน้ี 

 

 

 
 
 
 
 

คลกิเมาส์ในช่องตาราง
ท่ีต้องการก าหนดขนาด 

ก าหนดความกว้างและ
ความสงูของช่องตาราง 
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การซ้อนตาราง (Nested Table) 

 การสร้างตารางซอ้นกนันั้น สามารถช่วยในการน าเสนอขอ้มูลที่ซบัซอ้นได ้ดงัน้ี 

 

 

 
 

             
 

คลกิเซลล์ท่ีจะแทรกตาราง 

คลกิ  (Table) 
เพ่ือแทรกตารางใหม่ 

ก าหนดรูปแบบของตารางท่ีจะ

แทรกแล้วคลกิปุ่ ม  
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ก าหนดพืน้ตาราง 
 การปรับแต่งสีของตารางใน Properties Inspector มีรายละเอียดดงัน้ี 
 

 

 
 

แสดงตารางใหม่
ท่ีแทรกเข้ามาใน
เซลล์ท่ีเราเลือก 

ปรับแตง่ตารางใหมไ่ด้ตามต้องการใน Properties Inspector 

คลกิเลือกทัง้ตาราง 
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ก าหนดสีพืน้ ก าหนดสีขอบตาราง 

ก าหนดรูปแบบพืน้หลงัให้กบัช่องตาราง 

แสดงผลการก าหนดพืน้
ตาราง 
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การจดัเรียงข้อมูลในตาราง 

 Dreamweaver สามารถจดัเรียงขอ้มูลในตารางไดห้ลายรูปแบบ เช่น เรียงล าดบัตวัอกัษร หรือตวั
เลขที่อยูใ่นตารางจากคา้อยไปมากหรือมากไปนอ้ยได ้เป็นตน้โดยใชค้  าสัง่ Commands > Sort Table… ซ่ึงจะ
มีการก าหนดค่าต่างๆ ในการจดัเรียงขอ้มูลที่อยูใ่นตาราง ดงัน้ี 

 

 

 

 

คลกิเลือกทัง้ตาราง 

คลกิเลือกค าสัง่ 
Commands > Sort Table 
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 Sort   By  ก าหนดคอลมัน์หลกัที่จะใชใ้นการเรียงล าดบัขอ้มูล 

 Order  เลือกวธีิเรียงล าดบัขอ้มูล 

       

 

 Then    By   ถา้ขอ้มูลในคอลมัน์ทีก่  าหนดใหใ้ชใ้นการเรียยงล าดบัขอ้มูลเกิดซ ้ ากนั เราสามารุ
ก าหนดคอลมัน์เพิม่ที่ใชใ้นเรียงล าดบัขอ้มูลไดใ้นช่อง Then  By

 

- Sort   includes the first row  เลือกวา่จะเอาขอ้มูลในแถวแรกมาเรียงดว้ยหรือไม่ โดยปกติ
ขอ้มูลแถวแรกจะไม่ถูกน ามาเรียงเพราะ 

- Sort  header rows ท าการจดัเรียงขอ้มูลที่อยูภ่ายในแถวของส่วนหวัตารางดา้นบนที่เรียกวา่ 
Header (แทก็ <thead>) 

- Sort footer rows ท าการจดัเรียงขอ้มูลที่อยูภ่ายในแถวของส่วนทา้ยตารางดา้นล่างที่เรียกวา่ 
Footer (แทก็ <tfoot>) 

- Keep all row colors the same after the sort has been completed ก าหนดใหสี้พื้นหลงัของเซลล์
เป็นเหมือนเดิมหลงัจากท าการจดัเรียงขอ้มูล 

เลือกรูปแบบการจดัเรียงแล้ว
คลกิเมาส์ปุ่ ม  

เรียงตามตวัอกัษร เรียงคา่จากน้อยไปหามาก 

เรียงตามล าดบัตวัเลข เรียงคา่จากมากไปหาน้อย 
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การเชื�อมโยงเวบ็เพจ  (Link) 

มาตรฐานการเรียนรู้/ ตัวช้ีวดั 

กลุ่มสาระการงานอาชีพและเทคโนโลย ี

สาระที ่๒ การออกแบบและเทคโนโลยี 

           มาตรฐาน ง ๒.๑  เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ี ออกแบบและสร้างส่ิงของเคร่ืองใช ้

หรือวธีิการ ตามกระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรค ์ เลือกใชเ้ทคโนโลยใีนทางสร้างสรรค์

ต่อชีวติ  สงัคม   ส่ิงแวดลอ้ม  และมีส่วนร่วมในการจดัการเทคโนโลยทีี่ย ัง่ยนื 

ตัวช้ีวดั 
 ๑.ง ๒.๑/๑ อธิบายและเช่ือมโยงความสมัพนัธร์ะหวา่งเทคโนโลยกีบัศาสตร์อ่ืนๆ 

        ๒.ง ๒.๑/๔ มีความคิดสร้างสรรคใ์นการแกปั้ญหาหรือสนองความตอ้งการในงานท่ีผลิตเอง  หรือ

การ พฒันาผลิตภณัฑท่ี์ผูอ่ื้นผลิต 

สาระส าคญั 
      สามารถเช่ือมโยงความสมัพนัธร์ะหวา่งเทคโนโลยกีบัศาสตร์อ่ืนๆ และหลกัการวเิคราะห์ผลิตภณัฑ์

เบื้องตน้เป็นการวเิคราะห์จุดมุ่งหมายของการออกแบบ 

สาระการเรียนรู้ 

- ความรู้ 
   ๑.เขา้ใจการเช่ือมโยงความสมัพนัธร์ะหวา่งเทคโนโลยกีบัศาสตร์อ่ืนๆ 

   ๒.มีความคิดสร้างสรรคแ์ละจุดมุ่งหมายในการออกแบบ 

 - ทกัษะ / กระบวนการ 

    ๑.เช่ือมโยงความสมัพนัธร์ะหวา่งเทคโนโลยกีบัศาสตร์อ่ืนๆ ไดอ้ยา่งหลากหลาย 

    ๒.ทกัษะการการวเิคราะห์ผลิตภณัฑแ์ละกลุ่มเป้าหมายของงาน 
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- คุณลกัษณะทีพ่งึประสงค์ 

   ๑.มีวนิยั 

   ๒.ใฝ่เรียนรู้ 

   ๓.มุ่งมัน่ในการทางานรู้เรียนรู้ 
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การเช่ือมโยงเวบ็เพจ 

เราสามารถสร้างการเช่ือมโยงไดห้ลายแบบดว้ยกนัดงัน้ี 
 เช่ือมโยงภายในเวบ็เพจเดียวกนั
 เช่ือมโยงไปยงัหนา้เวบ็เพจอ่ืนหรือไฟลเ์วบ็เพจอ่ืนในเวบ็ไซตเ์ดียวกนั
 เช่ือมโยงไปยงัเวบ็ไซตอ่ื์น
 เช่ือมโยงไปยงัอีเมล ์(E-mail link)

 เช่ือมโยงไปยงัไฟลด์าวน์โหลด

การเช่ือมโยงภายในเวบ็เพจเดยีวกนั 

หากขอ้มูลในหนา้เวบ็เดียวกนัมีขนาดยาวมากท าใหต้อ้งใชเ้มาส์เล่ือนแถบสกอลบาร์ดู เราอาจหันมา
สร้างลิงคเ์ช่ือมโยงสองส่วนน้ี ดงัตวัอยา่งเม่ือเราคลิกขอ้ความที่เราก าหนดให้เป็นลิงค ์ก็จะเกิดการกระโดด
ไปยงัส่วนล่างของหนา้เวบ็เดียวกนั 

การเช่ือมโยงภายในเวบ็เพจเดียวกนัน้ี จะตอ้งมีการก าหนดจุดเช่ือมโยงที่เรียกว่าจุด Anchor (Anchor 
point) เพือ่ใหเ้กิดการกระโดดไปถึงเม่ือมีการคลิกขอ้ความลิงค ์ดงัตวัอยา่งเราจะก าหนดใหรู้ปภาพ “” เป็นจุด 
Achor ดงัรายละเอียดต่อไปน้ี 

ขั้นตอนที่ 1 ก าหนดจุด Achor 

วธีิการก าหนดจุด Anchor ท าไดด้งัน้ี 

1. ก าหนดจุด Anchor

2. คลิกปุ่ ม  ในแท็บ Common หรือเลือกเมนู Insert > Named Anchor หรือกด <Ctrl+Alt+A>
เพือ่ก าหนดจุดเช่ือมโยง

3. จะปรากฏหน้าต่าง Named Anchor จากนั้นในช่อง Anchor name ให้เราตั้งช่ือจุด Anchor แลว้
คลิกปุ่ ม  เพือ่ตกลง

การเช่ือมโยงเวบ็เพจ  (Link) 
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4. จะแสดงสญัลกัษณ์สมอเรือ  แสดงวา่ไดก้  าหนดจุดการเช่ือมโยงแลว้ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

คลกิเลือกจดุท่ีต้องการสร้างเป็นจดุ Anchor คลกิปุ่ ม   ในแท็บ Common 
เพ่ือก าหนดจดุเช่ือมโยง 

ตัง้ช่ือจดุ Anchor แล้วคลกิปุ่ ม 

  เพ่ือตกลง 
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ขั้นตอนที่ 2 ก าหนดข้อความที่จะสร้างเป็นลิงค์ 

 ต่อไปเราจะสร้างขอ้ความใหเ้ป็นลิงคเ์พือ่เช่ือมโยงไปยงัจุด Anchor ที่เราสร้างไว ้
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

จะแสดงสญัลกัษณ์
สมอเรือ   แสดงวา่ได้ก าหนด
จดุการเช่ือมโยงแล้ว 

ก าหนดจดุท่ีจะเช่ือมโยง โดยพมิพ์ # ตามด้วยช่ือจดุ 
Anchor ท่ีตัง้ไว้ จากนัน้กดคีย์ <Enter>  

เลือกข้อความท่ีจะ
สร้างลงิค์  
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 ท าการบนัทึกการท างาน และกดปุ่ ม <F12> เพือ่ทดสอบดูผลลพัธข์องการเช่ือมโยงภายในหนา้เวบ็
เพจเดียวกนั เม่ือเราคลิกที่ต  าแหน่งที่สร้างจุดเช่ือมโยงไว ้โปรแกรมจะแสดงเน้ือหาไปยงัต าแหน่งที่เราสร้าง
จุด Anchor ไวใ้นขั้นตน้ 

 

 

 

คลกิเมาส์ท่ีลงิค์ท่ี
สร้างไว้  

เม่ือคลกิเมาส์
โปรแกรมจะแสดง
เนือ้หามายงัจดุ Anchor 
ท่ีก าหนดให้เช่ือมโยงไว้  
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เช่ือมโยงภายในเว็บไซต์เดียวกัน 

 เป็นการเช่ือมโยงจากหนา้เวบ็หน่ึงไปยงัอีกหนา้เวบ็หน่ึงที่อยูภ่ายในเวบ็ไซตเ์ดียวกนั มีขั้นตอนดงัน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

เลือกข้อความท่ีจะ
ก าหนดเป็นลงิค์  

ก าหนดจดุท่ีจะเช่ือมโยงโดยคลกิปุ่ ม    

เลือกไฟล์เวบ็เพจท่ีต้องการเช่ือมโยง

และคลกิเมาส์ปุ่ ม   
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 เม่ือเราสัง่บนัทึกการท างาน และกดปุ่ ม <F12> เพือ่ทดสอบดูผลลพัธก์ารเช่ือมโยงภายในเวบ็ไซต์
เดียวกนั เม่ือเราคลิกลิงคท์ี่สร้างไว ้จะเปิดหนา้เวบ็เพจที่เราก าหนดเช่ือมโยง 

 
 

 

 

 

 

 

 

 

แสดงช่ือหน้าเวบ็ท่ีเราจะเช่ือมโยงด้วย  

เลือกข้อความท่ีก าหนดเป็นลงิค์  

จะเปิดหน้าเวบ็เพจท่ีเราก าหนดเช่ือมโยง 
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การเช่ือมโยงไปเว็บไซต์อื่น 

 ในการเช่ือมโยงกบัเวบ็ไซตอ่ื์น ใหเ้ราระบุ URL ของเวบ็เพจนั้น โดยพมิพ ์http:// น าหนา้ช่ือเวบ็เพจ
ที่เราตอ้งการเช่ือมโยงดว้ยทุกคร้ัง เราสามารถก าหนดใหข้อ้ความหรือภาพที่อยูห่นา้เวบ็ เป็นลิงคเ์ช่ือมโยงไป
ยงัเวบ็ไซตอ่ื์นได ้

 

 

 

 

 

 

 

 

 

 

 

  

 ใหเ้ราสัง่บนัทึกการท างาน และกดปุ่ ม <F12> เพือ่ทดสอบดูผลลพัธก์ารเช่ือมโยงไปยงัเวบ็ไซตอ่ื์น 
เม่ือเราคลิกภาพหรือขอ้ความ จะเป็นการลิงคไ์ปยงัเวบ็ไซตท์ี่เราก าหนดไว ้

 

 

 

เลือกภาพหรือข้อความท่ีต้องการเช่ือมตอ่ 

พมิพ์ช่ือ URL เวบ็ไซต์ท่ีเราต้องการเช่ือมโยงแล้วกดคีย์ <Enter>  
เช่น  http://www.google.co.th  
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การเช่ือมโยงไปยังอีเมล์ 

 เพือ่ใหผู้ท้ี่มาเยีย่มชมเวบ็เพจของเราติดต่อเราได ้มกัมีการสร้างลิงคช้ี์ไปยงัอีเมลแ์อดเดรสของเรา 
เม่ือผูใ้ชค้ลิกที่ลิงคน้ี์ก็สามารถเขียนอีเมลม์าคุยกบัเราได ้โดยไม่ตอ้งเสียเวลาพมิพอี์เมลแ์อดเดรสของเรา 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 ใหส้ัง่บนัทึกหนา้เวบ็ และกดปุ่ ม <F12> เพือ่ทดสอบดูผลลพัธก์ารเช่ือมโยงดว้ยอีเมล ์เม่ือเราคลิก
เมาส์ที่เราก าหนดเป็นลิงค ์ก็จะเปิดโปรแกรมส่งเมล ์
 
 
 
 

เลือกภาพหรือข้อความท่ีต้องการเช่ือมโยง 
พมิพ์อีเมล์แอดเดรสท่ีช่อง Link โดยมีค าวา่ mailto: ตาม
ด้วยอีเมล์แอดเดรสท่ีต้องการให้สง่แล้วกดคีย์ <Enter> 

(mailto:bkk_training@hotmail.com) 
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การเช่ือมโยงเพื่อดาวน์โหลด 
 ในเวบ็ไซตท์ัว่ไป อาจมีการน าโปรแกรมประเภทแชร์แวร์ และฟรีแวร์ หรือไฟลรู์ปภาพ สกรีนเซฟ
เวอร์ เกมส์ และเพลงต่างๆ มาให้โหลดไดฟ้รีๆ เพือ่ดึงดูดผูม้าเยีย่มชมหรือใชติ้ดต่อบริษทั  
 

 
 
 
 
 
 
 ใหส้ัง่บนัทึกหนา้เวบ็ และกดปุ่ ม <F12> เพือ่ทดสอบดูผลลพัธก์ารเช่ือมโยงเพือ่ดาวน์โหลดไฟลจ์าก
หนา้ต่างบราวเซอร์ เม่ือเราคลิกลิงค ์จะปรากฏไดอะลอ็กบอ็กซ์ File Download ใหโ้หลดมายงัเคร่ืองของเรา 
 
 
 
 
 
 

เลือกภาพหรือข้อความท่ีต้องการเช่ือมโยง 
คลกิท่ีปุ่ ม Brows  เพ่ือเลือกไฟล์ท่ีต้องการให้มีการ  
Download  โดยไฟล์ดงักลา่วอาจเป็น ไฟล์รูปภาพหรือไฟล์
เอกสาร 
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ก าหนดลกัษณะการเปิดหน้าเว็บใหม่ที่เช่ือมโยง 
 ที่ Property Inspector ในส่วนของ Target เราสามารถก าหนดวธีิเปิดหนา้เวบ็ที่เช่ือมโยงเม่ือมีการ
คลิกลิงคไ์ด ้ 
_blank  ใหเ้ปิดเวบ็ใหม่ที่เช่ือมโยงในหนา้ต่างบราวเซอร์ใหม่อีกหนา้ต่าง 
_parent  ใหเ้ปิดเวบ็ใหม่ที่เช่ือมโยงในหนา้ต่างบราวเซอร์เดิม 
_self  ใหเ้ปิดเวบ็ใหม่ที่เช่ือมโยงในหนา้ต่างบราวเซอร์เดิม หรือในกรอบเฟรมเดิม 
_top  ใหเ้ปิดเวบ็ใหม่ที่เช่ือมโยงในหนา้ต่างบราวเซอร์เดิม หรือในกรอบเฟรมนอกสุด 
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การจัดแบ่งหน้าเว็บเพจด้วย (Frame) 

มาตรฐานการเรียนรู้/ ตัวช้ีวดั 

กลุ่มสาระการงานอาชีพและเทคโนโลย ี

สาระที ่๒ การออกแบบและเทคโนโลยี 

       มาตรฐาน ง ๒.๑  เขา้ใจเทคโนโลยแีละกระบวนการเทคโนโลย ี ออกแบบและสร้างส่ิงของเคร่ืองใช ้

หรือวธีิการ ตามกระบวนการเทคโนโลยอียา่งมีความคิดสร้างสรรค ์ เลือกใชเ้ทคโนโลยใีนทางสร้างสรรค์

ต่อชีวติ  สงัคม   ส่ิงแวดลอ้ม  และมีส่วนร่วมในการจดัการเทคโนโลยทีี่ย ัง่ยนื 

ตัวช้ีวดั 
        ๑.ง ๒.๑/๓ สร้างและพฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลยอียา่งปลอดภยัโดย

ถ่ายทอดความคิดเป็นภาพฉายและแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  หรือถ่ายทอดความคิดของ

วธีิการเป็นแบบจ าลองความคิดและการรายงานผลโดยใชซ้อฟแวร์ช่วยในการออกแบบหรือน าเสนอผลงาน 
        ๒.ง ๒.๑/๔ มีความคิดสร้างสรรคใ์นการแกปั้ญหาหรือสนองความตอ้งการในงานท่ีผลิตเอง  หรือ

การ พฒันาผลิตภณัฑท่ี์ผูอ่ื้นผลิต 

สาระส าคญั 
      พฒันาส่ิงของเคร่ืองใชห้รือวธีิการ ตามกระบวนการเทคโนโลยอียา่งปลอดภยัโดยถ่ายทอดความคิดเป็น

ภาพฉายและแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน  และหลกัการวเิคราะห์ผลิตภณัฑเ์บื้องตน้เป็นการ

วเิคราะห์จุดมุ่งหมายของการออกแบบ 

สาระการเรียนรู้ 

- ความรู้ 
  ๑.หลกัในการพฒันาส่ิงของตามกระบวนการเทคโนโลย ี

  ๒.ถ่ายทอดความคิดเป็นภาพฉายและแบบจ าลองเพือ่น าไปสู่การสร้างช้ินงาน 

  ๓.มีความคิดสร้างสรรคแ์ละจุดมุ่งหมายในการออกแบบ 

113



 

 - ทกัษะ / กระบวนการ 

    ๑.การล าดบัความคิดในการพฒันาส่ิงของตามกระบวนการเทคโนโลย ี

    ๒.ทกัษะการการวเิคราะห์ผลิตภณัฑแ์ละกลุ่มเป้าหมายของงาน 

- คุณลกัษณะทีพ่งึประสงค์ 

   ๑.มีวนิยั 

   ๒.ใฝ่เรียนรู้ 

   ๓.มุ่งมัน่ในการทางานรู้เรียนรู้ 

 

  

 

 

 

 

 

 

 

 

 

114



 

 

การจดัแบ่งหน้าเวบ็ด้วยด้วยเฟรม   (Frame) 

 เฟรม  (Frame)  เป็นการจดัแบ่งหน้าต่างของเวบ็เพจออกเป็นส่วน ๆ เพื่อให้แต่ละส่วนแสดงเว็บ
เพจที่แตกต่างกนัตามที่เราก าหนด 

 

       

 

 

 

 

 

 

เฟรม (Frame )  และเฟรมเซ็ต  (Frameset) 

 เฟรม  Frame  เป็นพื้นที่ส่วนหน่ึงของหน้าเวบ็เพจที่ถูกเราจดัแบ่งไวเ้พื่อให้แสดงเวบ็เพจ ไดอ้ยา่ง
อิสระโดยไม่ขึ้นกบัส่วนอ่ืน ๆ  โดยโครงร่างและรายละเอียดในการจดัแบ่งเฟรม  เช่น  จ  านวนเฟรม  ขนาด  
ต  าแหน่งของเฟรม และช่ือเวบ็เพจที่เร่ิมตน้แสดงในแต่ละเฟรมจะถูกจดัเก็บไวเ้ป็นไฟล์  HTML  ที่เรียกว่า  
เฟรมเซ็ต Frameset  

 

 

 

 

การจดัแบ่งหนา้เวบ็เพจดว้ย (Frame) 
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การสร้างเฟรม 

 เราสามารถที่จะสร้างเฟรมได ้ 2 ทางคือ   สร้างขึ้นเองตามแบบที่เราตอ้งการ  หรือเลือกจากแบบ
ส าเร็จที่โปรแกรมจดัเตรียมไวใ้ห้  โดยสามารถสร้างจากไฟล ์Web page ที่สร้างไวแ้ลว้ หรือสร้างจากไฟลท์ี่
สร้างใหม่ 

การสร้างเฟรมจากเวบ็เพจทีส่ร้างไว้แล้ว 

วธีิที ่1 

 1.   วางตวับอกต าแหน่งการพมิพใ์นเวบ็เพจ 
 2.   น าเมาส์คลิกที่แทป็ค  าสัง่  Layout    >>  Frames 
 
 
 
 
 
 
 
 
 
 
 
 
 
3.   หลงัจากเลือกรูปแบบของ  Frames  ที่ตอ้งการแลว้จะปรากฏดงัรูป 
 
  
 
 
 
 

เลือกรูปแบบของ  
Frames  ท่ีต้องการ 
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วธีิที ่2 
 1.   เลือกเมนูค  าสัง่  File  เลือกค าสัง่   New   จะปรากฏหนา้ต่าง  New   Document 
 2.   เลือก Page from Sample   ในส่วนของ Sample Folder  เลือก  Frameset  
 3.   จากนั้นท าการท าการเลือก Sample Page  จากรายการที่แสดง  โดยโปรแกรมจะแสดงตวัอยา่ง 
                   ทางดา้นขวามือดงัรูป 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 4.  เม่ือเลือก Frameset  จากรายการเรียบร้อยแลว้ใหค้ลิกที่ปุ่ ม   
 
 
 
 
 
 
 
 
 

 

เลือก Frames   แบบ
ส าเร็จรูปท่ีต้องการ 
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การสร้างเฟรมเซ็ตตามแบบทีเ่ราก าหนดเอง 

-  การสร้างเฟรม 

1. สร้างเวบ็เพจใหม่ 
2. เลือกเมนูค  าสัง่  Modify  เลือก  Framesset 
3.    จากนั้นเลือกรูปแบบที่ตอ้งการ 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

เลือกรูปแบบ  
Frameset  ท่ีต้องการ 
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การแบ่งเฟรมย่อย 
 คลิกที่เมนูค  าสัง่  View  เลือกค าสัง่   Visual  Aids  เลือกค าสัง่  Frame  Borders  เพือ่ก าหนดใหมี้เสน้
ขอบของเฟรมที่ถูกเลือกไวก่้อนหนา้น้ี 
 

  

  
 
 
 
 
 
 
 
 
 
 
 
  1.   น าเมาส์คลิกคา้งไวท้ี่เสน้ขอบของเฟรม  (Frame  Borders)   
  2.   ดรากส์เมาส์ลากเสน้ขอบของเฟรมออกมาตามที่ตอ้งการ 

 

 

 

 

 

  

 

เลอืกค าสัง่  Frame  
Borders   

ลากเส้นขอบของ
เฟรมออกมา
ตามท่ีต้องการ 
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 3.   หากตอ้งการแบ่งเฟรมออกเป็น  4  เฟรมใหน้ าเมาส์ดรากส์ลากจากมุมของเฟรม  จะเห็นวา่หวั
ของ  ตัวช้ีเมาส์  (Pointer) จะเป็นรูป   
 

 

 

 

 

 

 

 

 

 

 4.    เลือกค าสัง่ Window>>Frames เพือ่เปิดหนา้ต่างเฟรมออกมา เพือ่ช่วยในการแบ่งเฟรม   

 
 

 

 

 

 

 

 

บริเวณที่คลิกเมาส์  

 

Window Frames 
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คลิกเมาส์ลากแบ่งเฟรมยอ่ยออกมา 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. คลกิ 

2. ลากเส้นจากขอบ 

ผลลพัธ์ท่ีได้ 
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การปรับแต่งเฟรม 

 เม่ือสร้างเฟรมขึ้นเองโดยไม่ใชเ้ฟรมส าเร็จรูปก็ตอ้งท าการปรับแต่งขนาด  และแบบของเฟรมที่
สร้างดว้ยตนเองเพือ่ใหไ้ดโ้ครงสร้างตามที่ตอ้งการ ส าหรับการปรับแต่งเฟรมมีรายละเอียดแบ่งเป็นหวัขอ้ได้
ดงัตวัอยา่งต่อไปน้ี 

- การปรับขนาดเฟรม 

เราสามารถปรับขนาดของเฟรมเพือ่ใหไ้ดเ้ฟรมที่มีขนาดตามตอ้งการดว้ยวธีิการแดรกเมาส์คา้งไวท้ี่
เสน้แบ่งเฟรมแลว้ลากไปยงัจุดที่ก  าหนดทั้งในแนวตั้ง หรือแนวนอน ซ่ึงท าไดด้งัน้ี 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. คลกิเส้นแบง่เฟรมท่ีขอบเวบ็เพจ 
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2. คลกิลากเส้นแบง่
เฟรมไว้ต าแหน่งท่ี
ต้องการ 

3. เม่ือได้ต าแหน่งท่ีต้องการแล้ว
ให้ปลอ่ยเมาส์ 
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การเพิ่มเฟรมย่อย 

เม่ือแบ่งเฟรมดว้ยตนเองแลว้ยงัเพิม่เฟรมยอ่ยจากเฟรมที่สร้างขึ้นเดิมไดโ้ดยการไปที่ค  าสัง่ 
Modify >>Frameset จากนั้นเลือกวธีิการเพิม่เฟรมจาก Split Frame แบบต่างๆ โดยสามารถแบ่งเฟรมทั้ง
แนวตั้งหรือแนวนอนซ่ึงท าไดด้งัน้ี 

 Split Frame  Left  แสดงเฟรมหลกัทางซา้ย 

 Split Frame  Right  แสดงเฟรมหลกัทางขวา 

 Split Frame Up   แสดงเฟรมหลกัดา้นบน 

 Split Frame Down แสดงเฟรมหลกัดา้นล่าง 
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การลบเฟรมย่อย 
บางคร้ังเฟรมที่สร้างขึ้นมาอาจไม่ไดใ้ชง้านหรือไม่เป็นตามตอ้งการ กอ็าจจะลบเฟรมนั้นออกได้

ดงัน้ี 

 1 แดรกเมาส์ตรงเสน้แบ่งเฟรมที่ไม่ตอ้งการ และตอ้งการลบออกจากหนา้เวบ็เพจ 

 2 จากนั้นลากไปหาขอบเวบ็เพจโดยเสน้เฟรมแนวตั้งใหล้ากไปที่ขอบดา้นซา้ยส่วนเสน้แนวนอนให้
ลากไปทีข่อบดา้นบน 

 

 

 

 

 

 

แสดงการเพิม่ด้วย  Split Frame Up   
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การปรับแต่งคุณสมบัติของ เฟรม 

1. เลือกเฟรมที่ตอ้งการ 

 

 

 

 

 

 
 
 
 
 

เฟรมท่ีแบง่ไว้หายไป 
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2. ปรับค่าต่าง ๆ ในพาเนล  properties 
 

 
 
 
 
 
 
 
 
 
 
 
 

การเปลีย่นสีพืน้หลงัของเฟรม 

 1.   เลือกเฟรมที่ตอ้งการจะเปล่ียนสีพื้นหลงั 
 2.   คลิกที่เมนูค  าสัง่  Modify  เลือกค าสัง่  Page  Properties     
 
 
 
 
 

 
 
 
 
 
 
 
 

ให้แสดงแถบเล่ือนหรือไม่ 

ก าหนดเวบ็เพจท่ีแสดงในเฟรม แสดงเส้นขอบเฟรมหรือไม่ 

ก าหนดระยะห่างระหวา่งขอบเฟรม
กบัเนือ้หา 

ตัง้ช่ือเฟรม 

ไมใ่ห้มีการปรับขนาดเฟรม เลือกเส้นสีขอบเฟรม 
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3.   จะปรากฏหนา้ต่าง   Page   Properties   ขึ้นมาใหป้รับตั้งค่าต่าง ๆ 
 

 
 
 
 4.   คลิกเมาส์ที่   Background           จะปรากฏหนา้ต่างใหเ้ลือกสีตามตอ้งการ 
 
 
 
 
 
 
 5.   จากนั้นคลิกที่ปุ่ ม  OK  เฟรมจะเปล่ียนเป็นสีตามที่เลือกไว ้
 

 

 

 

เลือก Background    
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การเปลีย่นพืน้หลงัของเฟรมเป็นรูปภาพ 

 1.   เลือกเฟรมที่ตอ้งการจะเปล่ียนพื้นหลงัเป็นรูปภาพ 
 2.   คลิกที่เมนูค  าสัง่  Modify   เลือกค าสัง่  Page  Properties   

3.   จะปรากฏหนา้ต่าง   Page   Properties  ขึ้นมาใหป้รับตั้งค่าต่าง ๆ 
 

 
 

 
 
 
 
 
 
 
 
 
 4.   คลิกเมาส์ที่   Browse   จะปรากฏหนา้ต่างใหเ้ลือก 
 

 
 
 
 
 
 
 
 
 
 
 

5. คลิกที่ปุ่ ม  OK  เฟรมจะเปล่ียนเป็นรูปภาพตามที่เราเลือก 

เลือก Background   Image 
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การปรับค่าเฟรมเซ็ต 

 1.   เลือกเฟรมเซ็ตที่ตอ้งการ  โดยคลิกที่เสน้แบ่งเฟรมเพือ่เลือกเฟรมเซ็ตของชุดเฟรมนั้น ๆ 
 2.   จะปรากฏพาเนล  Properties   ของเฟรมเซ็ตขึ้นมาใหท้  าการปรับตั้งค่า 
 
 
 
 
 
 
 
 
 
 
 
 

การปรับขนาดเฟรม 

1. คลิกที่แทบ็ที่อยูข่อบดา้นซา้ยเพือ่เลือกปรับขนาดในแนว    Row    
หรือ คลิกที่แทบ็ที่อยูข่อบดา้นบนเพือ่เลือกปรับขนาดในแนว    Column 

 
 
 
 
  
 
 
 
 2.    ก าหนดขนาดของเฟรมโดยใส่ค่าในช่อง   Value    
 
 
 

ทบ็ดา้นบน 

แทบ็ดา้นซา้ย 

ให้แสดงเส้นขอบเฟรมหรือไม่ เลือกสีเส้นขอบเฟรม 

ก าหนดความหนาของเฟรม ปรับขนาดเฟรม 

แท็บ 
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การเช่ือมโยงข้อมูลภายในเฟรม 

 1.   เลือกขอ้ความหรือรูปภาพในเฟรมที่จะใชเ้ป็นจุดเช่ือมโยง 

 
 
 
 
 
 
 
 
  
 
 
 
 
 
 
 
 
 
 2.   ในส่วนของ   Link  ในพาเนล  Properties  ใหก้ าหนดไฟลท์ี่จะเช่ือมโยงไปถึง 
         
 
 
 
 
 
 
 
 

ก าหนดไฟล์ท่ีจะ
เช่ือมโยงไปถึง 

เลือกข้อความ 
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 3.   คลิกที่               เพือ่เลือกไฟลท์ี่ตอ้งการเช่ือมโยงไปถึง 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 4.   เม่ือเลือกขอ้ความหรือรูปภาพเป็นจุดเช่ือมโยงเรียบร้อยแลว้ จะปรากฏดงัน้ี 
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5.   เลือกส่วนของ  Target  เพือ่เลือกเฟรมที่จะใชแ้สดงเวบ็เพจนั้น 
 
 
 
 
 
โดยเลือกรูปแบบดงัน้ี 
 _bank  เปิดไฟลใ์นหนา้ต่างใหม่ 
 _parent  เปิดไฟลใ์นเฟรมหลกัหรือหนา้หลกัที่จุดเช่ือมโยงอยู ่
 _self  เปิดไฟลใ์นเฟรมหรือหนา้ต่างเดียวกบัจุดเช่ือมโยงอยู ่
 _top  เปิดไฟลน์ั้นในแบบเตม็จอโดยยกเลิกเฟรมทั้งหมด 

เราสามารถก าหนด  Target   เพิม่ไดโ้ดยวธีิการดงัน้ี 

 1.    คลิกเลือกเฟรมใหมี้จุดไข่ปลาลอ้มรอบ    
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 2.   ก าหนดช่ือในช่อง   Frame  name   

 

 

 
 

3.   ในส่วนของ   Target  จะเพิม่ช่ือ  Frame  name  เขา้มาใหเ้ลือกก าหนด  เป้าหมายมากขึ้นตามที่
เราตอ้งการ 

 

 

 

  

4.   ใหเ้ลือก  Target  ที่ตอ้งการแลว้กดปุ่ ม  F12  เพือ่ทดสอบดูผลในหนา้ Preview  in  Browser   

การเลอืกเฟรมและเฟรมเซ็ตในหน้าต่าง  Document 

 เม่ืออยูใ่นมุมมอง  Design  ของหนา้ต่าง  Document  การคลิกภายในเฟรมเพือ่วางตวับอกต าแหน่งการ
พมิพจ์ะไม่ถือวา่เป็นการเลือกเฟรม ซ่ึงการเลือกเฟรมจะตอ้งกระท าดงัน้ี 

           กดปุ่ ม  Alt   คา้งไวแ้ลว้คลิกภายในเฟรมเพือ่เลือกนั้น หรือ คลิกที่เสน้แบ่งเฟรมเพือ่เลือกเฟรมเซ็ต 

เฟรมที่ถูกเลือกจะแสดงเส้นขอบเฟรมนั้นดว้ยเส้นไข่ปลา    และเม่ือเลือกเฟรมเซ็ต เส้นแบ่งเฟรม
ทุกเส้นก็จะแสดงดว้ยเส้นไข่ปลา  ส่วน Panel ของ Properties ก็จะแสดงค่าต่างๆ ของเฟรมและเฟรมเซ็ต
ตามที่เราเลือกเพือ่ใหเ้ราสามารถปรับค่าต่างๆ ไดโ้ดยสะดวก 
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การสร้างเนือ้หาลงในเฟรม 

 ในการสร้างเน้ือหาลงในเฟรมนั้น  เราอาจท าการสร้างขึ้นใหม่โดยการพิมพเ์น้ือหาลงไปโดยตรง
แลว้ท าการบนัทึกเฟรมที่สร้างเน้ือหาลง   หรือเปิดใชไ้ฟลเ์วบ็เพจที่เราสร้างไวแ้ลว้ก็ได ้
 การเปิดใชไ้ฟลเ์วบ็เพจที่สร้างไวแ้ลว้จะกระท าไดโ้ดย 
 1.    คลิกเมาส์ภายในเฟรมที่ตอ้งการน าไฟลเ์วบ็เพจที่สร้างไวแ้ลว้มาใช้งาน 
 2.    เลือกเมนูค  าสัง่  File   เลือกค าสัง่   Open  in  Frame 
 3.    เลือกไฟลเ์วบ็เพจที่ตอ้งการ   จากนั้นคลิกที่ปุ่ ม  OK   
 
 
  
 
 
 
 
 
 
 
 
 
 

การบันทกึเฟรมและเฟรมเซ็ต 

   การบันทกึเฟรมเซ็ต 
1.  คลิกที่เสน้แบ่งขอบของเฟรมเพือ่เป็นการเลือกเฟรมเซ็ต                                                                 
จะสงัเกตวา่มีเสน้ไขปลาอยูท่ี่ เสน้ขอบของทุกเฟรม 
 2.   เลือกเมนูค  าสัง่  File  เลือกค าสัง่  Save  Frameset  หรือ  
                       Save   Frameset  As 

 
 
 
 

เลือกไฟล์เว็บเพจท่ีต้องการ 
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 3.   จะปรากฏหนา้ต่าง   Save as   ใหเ้ราตั้งช่ือ Frame  set  ในช่อง  File name 
       จากนั้นคลิกที่ปุ่ ม  Save 
 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 

   การบันทกึเนื้อหาภายในเฟรม 
 1.   คลิกเลือกเฟรมที่ตอ้งการ 
 2.   เลือกเมนูค  าสัง่  File  เลือกค าสัง่  Save  Frame  หรือ Save  Frame  As 
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3.   จะปรากฏหนา้ต่าง   Save  As   ใหเ้ราตั้งช่ือ  Frame    ในช่อง  File  Name   
      จากนั้นคลิกที่ปุ่ ม  Save 
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